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Introduction
The Rumba System Administrator Guide has been written to help system administrators to:

• Plan the deployment of Rumba software
• Install Rumba software
• Support your end users
• Troubleshoot Rumba software

This guide contains a number of sections, each focussing on one of Rumba's many features.

This guide is provided in Portable Document Format (PDF) so that you either read it online or print selected
information for your convenience.

Conventions used in this guide
The following conventions are used in this guide:

Item Description

File names File names and extensions are listed in monoface type.

Example: .rsda is the file extension of all Rumba
AS/400 profiles.

Note: Note text An item of interest.

Command Line Text that appears in the command line (either entered by
the user or generated as a response to user entry)
appears in monoface type.

Blue text Cross-references to additional information are in blue
text.

For More Information Pointers to other sections in this guide, to online help, or
to web pages available on the Internet.

What is in this guide
This section lists the available sections in this guide that are provided to help you with details of planning
and installing Rumba software, supporting users, and troubleshooting software. T

• General Information

• Rumba Features

An overview of the entire Rumba product suite, including new features and descriptions of individual
Rumba host products

• Installation

Instructions for installing and deploying Rumba software
• Introducing Rumba

Primary features of Rumba Mainframe Edition, available documentation, Rumba profiles, and menu
commands

• Introducing Rumba Telnet Edition
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(relevant to Rumba Telnet Edition only) Primary features of Rumba Telnet Edition, including Rumba
applications available for the different hosts

• AS/400 and Mainframe Printers

AS/400 (3812 emulation) and Mainframe printer features, printing AS/400 documents on a PC
printer, monitoring and controlling printers and print jobs, and formatting printed documents

• Rumba AS/400

• AS/400 Getting Connected

Interface configuration procedures
• AS/400 File Transfer

AS/400 file transfer overview, administrative strategies, and SQL tutorials
• AS/400 Client Applications

AS/400 client applications, such as Shared Folders, Virtual Print, Submit Remote Command, and
Data Queues

• Rumba Mainframe

• Mainframe File Transfer

Individual and batch file transfers, TRANSXX codes
• Rumba UNIX-HP

• File Transfer

UNIX and HP file transfer concepts and procedures
• End-user Productivity Tools

• Automating Rumba Software

Creating, running, and distributing Rumba software, using macros as Hotspots, and placing macros
on toolbars

• System Administrator Tools

• Other Connection Tools

Alternative connection tools for Rumba Mainframe Edition and Rumba AS/400 Edition interfaces
• Tools

Diagnostic tools for tracing and recording communication sessions, and application development
tools such as the Development Kit (ODK) and legacy APIs, such as APPC and EHLLAPI

Available documentation
In addition to this guide, documentation for Rumba software consists of the ReadMe file and the Rumba
Help.

ReadMe file

The ReadMe file contains late-breaking information on Rumba software. To better address
the needs of our customers, there are many different Rumba products. Some of these
products may share the same ReadMe file. Therefore, the ReadMe file may contain
information about other Rumba products, in addition to information about the product you
are currently installing.

On initial installation, the final screen of the installation program asks you whether you
want to read the ReadMe file. After installation, the default location of the ReadMe file is
C:\Program Files\Micro Focus\Rumba\readme.html.

Rumba Help
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Information on how to customize and use Rumba software can be found in the online
Rumba Help. The Help does not include installation information. For details on installing,
see Rumba Installation Guide.

You can start the Help by:

• Choosing Rumba Help Topics from the Rumba Help menu (in the Classic interface)
• Clicking on the Rumba toolbar

This will open a help topic relevant to what you are currently doing in Rumba. From here
you can browse the Table of Contents or search for specific terms.

Contacting Micro Focus

Visit the Micro Focus Web site at www.microfocus.com. Our Web site gives up-to-date
details of contact numbers and addresses.

The Customer Care site contains considerable additional information, including the
WebSync™ service, where you can download fixes and documentation updates. To
connect, enter http://supportline.microfocus.com in your browser to go to the Customer
Care home page. You may need to log in to use certain services.
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Rumba Features
This section is intended for information solution providers who are evaluating Rumba software, and for
system administrators who want a quick summary of the features that are included in a Rumba product.

Introducing Rumba
This section introduces the entire Rumba product line, which provides access to multiple host types: IBM
Mainframe, IBM AS/400, UNIX, OpenVMS, and HP. Your Rumba software may be able to access one or
all of these host types depending on your individual needs.

Rumba feature descriptionscontains summary descriptions of the standard features in the various Rumba
host products.

Product overview
Rumba is a software suite that connects your users to information residing on multiple hosts and servers
across your organization. With Rumba, you have your choice of protocols such as TCP/IP and Rumba
Router (MPTN).

All Rumba products operate on Windows 7, Windows Vista, Windows XP, Windows 2003, WTS, and Citrix
Presentation Server. In addition to providing multiple access solutions, the Rumba product suite:

• Gives users tools with which they can view, print, and transfer data located anywhere in the
organization. These tools help users attain a higher level of efficiency.

• Gives system administrators flexibility in deploying and maintaining Rumba software.
• Offers developers the functionality needed to quickly generate custom client/server solutions using

ActiveX technology.

Rumba product listing
Rumba products are designed to meet our customers’ specific access needs. Micro Focus produces and
packages Rumba products to support multiple or single host access needs, with multiple connection
solutions. We also provide Rumba software versions for popular LANs, and migration products that help
you move from one Rumba product to another as well as from competitor products to Rumba.

The remainder of this section consists of three tables that list the variety of Rumba products available. The
first two tables list the Rumba product (as a general overview, and then as the individual applications that
may be included), with a brief description. Each table first lists multiple protocol products and then products
that include network-specific protocols. The third table lists migration products with a short explanation of
what they do.

Product Overview
The following table lists multiple-host Rumba products. The multiple network protocol product is listed first,
followed by network-specific protocol products.

Rumba product Product description Connection requirement

Rumba OFFICE • Supports IBM Mainframe, IBM AS/
400, Digital OpenVMS and UNIX

Multiple network protocols
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Rumba product Product description Connection requirement

systems, and HP 3000 and 9000
systems

• Supports multiple servers and
network protocols

• Supports display, printing, and file
transfer capabilities for all hosts

• Provides browser-to-host
connections and an integrated set
of Internet applications

Rumba Telnet Edition • Supports IBM Mainframe, IBM AS/
400, Digital OpenVMS and UNIX
systems, and HP 3000 and 9000
systems

• Designed specifically for the
Telnet network protocol

• Supports display, printing, and file
transfer capabilities for all hosts

• Provides browser-to-host
connections and an integrated set
of Internet applications

Telnet, TCP/IP

Individual application features
The following table provides information on the applications that make up the Rumba suite.

Rumba application Feature description

Rumba Mainframe Edition • Supports the IBM Mainframe
• Supports multiple servers and network protocols
• Supports display, printing, and file transfer capabilities

for the mainframe host
• Provides browser-to-host connections and an

integrated set of Internet applications

Rumba AS/400 Edition • Supports the IBM AS/400
• Supports multiple servers and network protocols,

including native TCP/IP
• Supports display, printing, and file transfer capabilities

for the AS/400 host
• Designed to maximize the file, print, and database

serving capabilities of the AS/400 with such features
as Shared Folders, Submit Remote Command, Virtual
Print, Data Queues, and Rumba AS/400 Optimized
Server Driver

• Provides browser-to-host connections and an
integrated set of Internet applications

Rumba UNIX-HP Edition • Supports Digital OpenVMS and UNIX systems
• Supports multiple servers and network protocols
• Supports display, printing, and file transfer capabilities

for the UNIX and VMS host
• Provides browser-to-host connections and an

integrated set of Internet applications
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Rumba application Feature description

• Supports HP 3000 and 9000 systems and UNIX
systems supporting HP terminal types

• Supports multiple servers and network protocols
• Supports display, printing, and file transfer

capabilities, including MPE native file transfer, for the
HP host

• Provides browser -to-host connections and an
integrated set of Internet applications

Rumba feature descriptions
This section contains a brief description of the new features in this release as well as the standard features
in the various Rumba host applications.

• Host-specific features are features that are available only with the appropriate host application. For
example, the Rumba Mainframe Display is considered a host-specific feature because it is available
only in installations that include the Rumba Mainframe application.

• Shared features are those features that can be found in most Rumba products. Some shared features
include the separate Macro Editor (which is bundled with most editions of Rumba), keyboard
configuration, and other tools for end-users, system administrators, and developers.

For detailed instructions on how to use each of these new features, whether shared or host-specific, see
the online help provided with the product.

New shared features
The following list briefly describes the new shared features available in this release. This release of Rumba
provides:

• Rumba supports specifying Internet Protocol version 6 (IPv6) formatted IP addresses for hosts. IPv6
support provides the functionality to connect to hosts on the network as Internet technology continues to
grow.

• The new Rumba Tracer feature records information about a program's execution (see Rumba Tracer).

New AS/400 features
The following new features are available in AS/400 applications (Display, Printer, and AS/400 File
Transfer).

• Spell checking
• Automatic hyperlink detection
• Automatic email address detection

New mainframe features
Rumba provides the following new mainframe features:

• Spell checking
• Automatic hyperlink detection
• Automatic email address detection
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Host-specific feature descriptions
This section describes the features specific to individual Rumba host applications.

These feature descriptions are organized by host in tables with a listing of features and a short description
of what each feature does.

Rumba Mainframe Edition
Mainframe Display and Printer. With the Mainframe Display, they view host applications and transfer files.
With the Mainframe Printer, they can route jobs from the mainframe printer queue to a Windows printer.
Both the Mainframe Display and Printer use interfaces to connect to the host.

The following provides summary descriptions for Rumba Mainframe Edition standard features and
interfaces.

Table 1: Standard features

Feature Description

Display • Presents the traditional mainframe display terminals
(3278/79) in a Microsoft Windows application: the
Rumba Page.

• Includes GDDM support, which makes working with
IBM mainframe graphics similar to using Windows
graphics packages.

• Users can run multiple host sessions, displaying and
working with PC and host applications simultaneously.

File transfer • Supports host file transfer programs IND$FILE and
SimXfer.

• Supports ASCII or binary transfers, Write Structured
Field or Buffered data streams, EBCDIC-to-ASCII
translation, and data compression.

• Provides DOS-based, batch, and drag-and-drop file
transfer features.

Switching system keyboards • Allows switching keyboard displays as in Windows
(ALT+SHIFT).

Table 2: Printer

Feature Description

Rumba Mainframe Printer (3287 emulation) Allows users to route jobs from the mainframe printer
queue to a Windows printer.

PC printer queues Lists the printer queues for all network and local printers
set up in Windows Print Manager.

Users can use PC Printer Queues to control Windows
printers.

Print log Lists documents that have printed through the Rumba
printer, including documents printed from host as well as
from PC applications.

Rumba Features | 13



Table 3: Interfaces

Feature Description

Microsoft SNA Server Connects to mainframe hosts through a suite of
integrated services. SNA Server acts as an SNA gateway
using two types of connections, client-to-server and
server-to-mainframe.

MPTN (SNA over TCP/IP) Connects to a mainframe host using SNA APPC to
communicate over TCP/IP networks.

Provides transparent access to functions such as
mainframe printing and file transfer.

TN3270E Uses a TCP/IP protocol stack to connect to a mainframe
host via a Telnet server.

New AS/400 features
The following new features are available in AS/400 applications (Display, Printer, and AS/400 File
Transfer).

• Spell checking
• Automatic hyperlink detection
• Automatic email address detection

Rumba UNIX-HP Edition
When using Rumba UNIX-HP Edition, users perform the majority of their tasks with the host using the
UNIX or the HP Display. This includes viewing host applications, transferring files, and printing from the
host. The UNIX Display and the HP Display connect to a host over a TCP/IP interface.

The following tables provide summary descriptions for UNIX and HP standard features.

Table 4: Rumba for UNIX

Standard feature Description

Display Presents the traditional VT display terminals in a
Microsoft Windows application supporting the whole
range of VT terminals from VT 52 to VT 420 as well as
VT340 ReGIS, Sixel, SCO ANSI, BBS ANSI and
Tektronix 4010/4014 graphics support.

Users can run multiple host sessions, displaying and
working with host applications simultaneously.

File transfer Supports Kermit, Text, and X-, Y-, Z-Modem file transfer
protocols over all the supported interfaces. It supports a
Rumba software initiated mode where the user need only
select the protocol and file to be transferred, and Rumba
software provides the underlying commands to
successfully transfer the file.

Enhanced security Supports SSL 3.0 (Secure Sockets Layer), TLS 1.0
(Transport Security Layer), and SSH (Secure Shell) to
allow users to securely access applications and transfer
data between their desktops and Mainframe, AS/400 and
UNIX systems, encrypting the session data stream to a
host capable of supporting these protocols.
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Standard feature Description

Switching system keyboards Allows switching keyboard displays as in Windows (ALT
+SHIFT).

Keyboard shortcut to open Split Display or History
window.

Provides a keyboard shortcut (CTRL+SHIFT+Z) to open
the Split display and History window on a UNIX Display.

Double-click auto select When connecting to UNIX and double-clicking data, the
data is automatically selected and copied to the
clipboard. Then when you right-click at the new location
the data is pasted without displaying the right-click, pop-
up menu.

Table 5: Printer

Standard feature Description

Terminal-routed printing Prints the display screen, selected text, and full color
graphics, or routes print jobs from the host printer through
your Windows print driver.

Table 6: Interfaces

Standard feature Description

Async Connects to a remote UNIX host through a phone line
and a standard asynchronous modem or directly to the
host or terminal controller using an RS-232 direct
connection.

Telnet Connects to the UNIX host using the TCP/IP protocol.

Table 7: Rumba for HP

Standard feature Description

Display Presents the traditional HP terminal types in a Microsoft
Windows application.

Users can run multiple host sessions, displaying and
working with host applications simultaneously.

File transfer Supports Kermit, Text, and Xmodem, Ymodem, Zmodem
file transfer protocols over all the supported interfaces,
and a proprietary protocol to HP3000 servers running the
MPE operating system. It supports a Rumba software
initiated mode where all the user needs to do is select the
protocol and the file to be transferred and Rumba
software will provide the underlying commands to
successfully transfer the file.

Table 8: Printer

Standard feature Description

Terminal-routed printing Prints the display screen or selected text, or routes print
jobs from the host printer through your Windows print
driver.
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Table 9: Interfaces

Standard feature Description

Async Connects to a remote HP host through a phone line and a
standard asynchronous modem, or directly to the host or
terminal controller using an RS-232 direct connection.

HP NSVT Connects to an HP host using the proprietary HP protocol
for Network Services Virtual Terminals (NSVT).

Telnet Connects to the HP host using the TCP/IP protocol.

Shared feature descriptions
This section describes the features shared between the Rumba products. Features, or components, are
shared because the Rumba architecture is based upon Microsoft’s ActiveX component technology. The
use of common components results in a common user interface and predictability in the way a Rumba
product works. Because the user sees the common user interface and experiences the same basic
functionality across Rumba products, Rumba common components reduce end-user training, saving time
and resources. The following table lists some of the newest standard features shared by the host-specific
products.

Table 10: All Rumba products

New Feature Description

Enhanced Security through SSL/SSH Supports SSL 3.0 (Secure Sockets Layer), TLS 1.0
(Transport Security Layer), and SSH (Secure Shell) to
allow users to securely access applications and transfer
data between their desktops and Mainframe, AS/400 and
UNIX systems, encrypting the session data stream to a
host capable of supporting these protocols.

Multiple HLLAPI sessions originating from the same
profile.

Permits running multiple HLLAPI sessions originating
from the same profile. This is an additional enhancement
to the API options currently available in Rumba.

Tools
All Rumba products contain the following tools:

• End-user productivity tools
• Rumba software installation and maintenance tools
• Developer tools

More complex and powerful task automation can also be provided by the Script Editor and Script Player
applications, provided separately.

End-user productivity tools
Rumba software applications contain tools that help end users attain a higher level of efficiency by
eliminating time-consuming file and application manipulation. For example, with these tools, your users can
copy from a host database and paste it into another application, like a spreadsheet or word processor. The
Paste Link facility automatically updates the data in a Windows application whenever both it and a Rumba
session to the host are open.

Other useful features include:
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• Rumba Office Integration. From within the Rumba 8.2 desktop, users can instantly send the current
screen text or image, fully or selectively into any Office item.

• Rumba Session Screens History Tracking. Rumba introduces an embedded, fully visual way of tracking
screens visited throughout a session. Users can go back to previously visited host screens and work on
them. This ability is enhanced with search capabilities, database navigation, export and import support
for session sharing, information sorting and automatic or manual capturing options.

• Rumba Toolbars Enhancements. Support for user-defined, customized toolbars that can be undocked
and ‘floated’,rather than just fixed and docked to the top of the application. Ability to define more types
of buttons and the ability to export and import toolbars to and from files.

• Enhanced Rumba Desk Management. The new Rumba desktop is designed to support the tiling and
repositioning of all session types within the Rumba desktop in an easy, dynamic and intuitive way. The
Rumba desktop can then be saved in the desktop profile to be reused when Rumba is restarted.

As a system administrator, you can help your users by:

• Automating log-on procedures by creating macros for them
• Setting up batch files that they can use to print multiple host screens to a PC printer (Print Area Setup)

Many of these features can help personalize the workplace. For example, you and your users can change
the look of a Rumba display by using watermarks or customizing the display.

The following table references the more important end-user tools for the Rumba suite. The table lists the
tools, then provides corresponding Rumba menus and commands, and brief descriptions.

Tool Menu/ Command Description

Rumba Desktop A tabbed interface to Rumba that
makes it easy to manage several
different sessions at once, even to
different hosts.

Profiles File/ New, Open, Save, Save As,
Properties Options/ Profile

Saves Rumba customized display/
printer and interface configuration
information. Using profiles, a user can
tailor a Rumba session for a specific
host or application and save it for re-
use. Session Profiles save
information relating to a single host
session, whereas Desktop Profiles
save a set of Session Profiles.

Print screen File/ Print, Print Preview Specifies how to print a screen within
the Rumba window. Users can print
to the Clipboard, current Windows
printer, or to a file. Users can also
designate printers and fonts, and
view how the screen will look when
printed.

Send screen File/ Send Screen Activates the user’s installed mail or
messaging system. Users can send a
screen without exiting the Rumba
window.

Print Area Setup File/ Print Area Setup Sets up batch files to print multiple
host screens to a PC printer.

Edit Clipboard Edit/ Undo, Cut, Copy, Paste Options/
Edit

Supports data cutting, copying, and
pasting activities.

Paste Area Setup Edit/ Paste Area Setup Sets up host screens to receive data
pasted from the Windows Clipboard.
Using this feature, users can paste
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Tool Menu/ Command Description

data from a third-party application into
multiple screens of a host application.

Title Bar View/ Title Bar Customizes the title bar text for the
Rumba window.

Configurable toolbars View/ Toolbars Customizes the Rumba toolbar. You
can create and modify toolbars to suit
user needs and preferences.

Note: This is currently
available only in the Classic
interface.

Watermark View/ Watermark Displays an image in the background
of the current Rumba window.

Status bar View/ Status Bar Toggles the 3D status bar on and off.

Customized display Options/ Display Customizes the look of the Rumba
window: fonts, colors, cursor settings,
and more.

Keyboard mapping Options/ Keyboard Maps special terminal keys to the PC
keyboard. Users can also select
different keyboards and international
keyboard options.

Capture Screen Options/ Capture Screen Setup,
Capture Screen

Captures the current Rumba screen
in a specified .txt file (or capture.txt if
no file is specified).

Macros Tools/ Run Macro, Record Macro,
Edit Macro, Macro Properties

Records a series of actions, such as
keystrokes and commands. Once
users record a macro, they can play it
back to automate routine tasks.

Users can assign macros to a
Hotspot (see below), a Rumba
toolbar button, or a key combination
on the keyboard.

Hotspots Tools/ Hotspots Makes any non-protected text on a
host screen into a Hotspot and
associates that text with a macro.
When the user clicks on the Hotspot,
the macro runs.

Customized menus View/ Toolbars Customizes Rumba menus. For
example, users can create new menu
items that start non-Rumba
applications.

Note: This is currently
available only in the Classic
interface.

Online help Help Provides detailed instructions on how
to use Rumba. Users can browse the
Contents for information, or search
for a specific term.
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Rumba software installation and maintenance
The most common way to connect Rumba software to a host is by selecting and configuring an interface
from the Rumba display or printer. However, if you are connecting to an IBM Mainframe or AS/400, there
are additional tools available to you. The following table provides descriptions for the other available
connection tools.

Table 11: Other connection tools

Application Description

APPC Configuration Utility Provides advanced configuration options for most
Mainframe and AS/400 interfaces. Allows for the
configuration of the following APPC items: Remote and
local logical units (LUs), Modes, transaction programs
(TPs), CPI-C side information, and conversation security
for TPs.

AS/400 Communications utility Used primarily to configure connections for Shared
Folders, Data Queues, Submit Remote Command, and
AS/400 file transfers.

Use the following diagnostic tools (available with all products) to monitor and troubleshoot Rumba
connections on your network.

Table 12: Diagnostic/Troubleshooting tools

Feature Description

Trace Console Traces and records communication sessions.
Specifically:

• Data streams from the Mainframe Display and Printer,
AS/400 Display and Printer, UNIX Display and HP
Display

• SNA communications
• Rumba Display APIs, such as DDE, EHLLAPI, and

WinHLLAPI; EHNAPPC
• Host System APIs, such as Data Queues, Shared

Folders, AS/400 file transfers, and Submit Remote
Command

Rumba Communication Monitor Displays an in-depth look at the connections of a
workstation.

Note: Not available for Rumba UNIX-HP Edition.

Developer tools
The AS/400 client applications, such as File Transfers, have APIs associated with them. Additionally, the
Submit Remote Command is available as ActiveX controls.

Rumba PC-to-Host consists of a family of ActiveX controls and Rumba Web-to-Host consists of both
ActiveX controls and JavaBeans. You may use these ActiveX controls and JavaBeans to create new
applications using languages such as Visual Basic, C++, and Java. Information and samples for using
these components can be found on the Micro Focus web site.
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Installing Rumba
This section is written for IT professionals and system administrators who want to customize, install and
deploy Rumba software.

The section contains instructions for installing Rumba on Windows XP, Windows Vista and Windows 7 with
Microsoft Installer technology. Additionally, it contains information about:

• Installing, modifying, repairing, and uninstalling Rumba software
• Customizing setup
• Microsoft installer command line arguments
• Transforms

Planning installation and deployment
This version of Rumba requires the latest Windows Installer service to install any Rumba feature on a
Windows operating systems. This new technology will require less of your management time and allow you
to design seamless deployment packages for Rumba.

Windows terminology
Before actually beginning a discussion of Rumba Setup it is a good idea to understand some basic
terminology and features of the Windows policy-based management environment.

• Roaming

In Windows versions from XP on, Windows allows you to move from computer to computer yet maintain
your specific desktop profile. Your login information enables this particular feature because your profile
information is located on a server.

• Microsoft Installer file types, .msi and .mst, and how to use them

The Microsoft Installer (.msi) replaces prior installation methods, and enables cleaner installs and
uninstalls, as well as repairs. The transform file (.mst) allows you to customize your Rumba
installations. Before using .mst, be sure to verify that you have the latest version of MSI installed. For
more information, read “Microsoft Installer service”, and How to Customize Setup.

• Publishing and Assigning with Intellimirror

Administrators can publish Rumba to users or assign Rumba to users or computers.

Administrators assign an application through Group Policy Objects. Assigned applications have
installation persistence: When a user selects the program for the first time, it will be installed. If a user
uninstalls an assigned application it will re-advertise immediately.

Administrators publish an application by making it available to users that may want the application. With
published applications, each user decides whether or not to install the application from the Control
Panel’s Add/Remove Programs utility.

You can only publish to users, not computers.
• Active Directory

Administrators deploy applications in Group Policy Objects (GPOs) that are associated with Active
Directory containers such as sites, domains, and organizational units (OUs). Intellimirror (Windows XP)
deployment requires Active Directory.
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Microsoft Installer service
The Windows Installer service manages applications at the component level and maintains reference
counts in the form of a client list of product codes (rather than integers), so it can identify clients of the
installed resource to synchronize counts. This allows clean and complete installs and uninstalls of Rumba,
whether simple or sophisticated.

Note: The Rumba installation will detect a previous Rumba 7.x installation and uninstall it before
installing the current version.

Supported operating systems
Rumba operates on PCs with the following operating systems, applications, and environments:

• Windows 7
• Windows Vista Business, Ultimate and Enterprise 32-bit versions
• Windows XP
• Windows Terminal Server (WTS)
• Citrix XenApp (formerly Presentation Server)
• Microsoft Application Virtualization (App-V)

Software requirements
The following software is required to install Rumba:

• Windows Installer 3.1 or later
• Microsoft .NET Framework 3.5 Service Pack 1
• Microsoft Visual C++ 2010 SP1 Redistributable Package (x86)

These can be installed from the Prerequisites folder or downloaded from the Microsoft web site.

In addition, the Microsoft Office .NET Interoperability Assemblies (PIA) is required. The PIA enables .NET
managed code to interact with a Microsoft Office application's COM-based object model. In most cases,
the PIA is installed during Office installation. However, sometime it is not. If you need to add the PIA:

1. In Control Panel, select Add/Remove Programs (Windows XP) or Uninstall a Program (Vista or
WIndows 7).

2. In the opened window, select the Microsoft Office installation and click Change.
3. Select Add or Remove Features.
4. Click Continue.
5. On the Installation Options page, click the plus sign (+) to expand the application for which you want

to install the PIA.
6. Click the drop-down arrow next to .NET Programmability Support, then select Run from My

Computer.

Hardware requirements
The following hardware is required to install Rumba:

• 400 MHz Pentium processor or equivalent (minimum). 1 GHz Pentium processor or equivalent
(recommended).

• 96 MB RAM (minimum). 256 MB RAM (recommended).

Disk space requirements can vary. Individual Rumba components share some common resources.
Therefore, the disk space needed for an installation that includes all components is significantly less that
required for separate installations. Single host installations generally use 40–60 MB and complete Rumba
software installations generally use about 100 MB, though actual usage may vary.
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Things to consider before installation
When you install Rumba software, Setup will prompt you for standard information. Plan your installation
based on the following questions (not necessarily in this order):

• Is this a first-time install, or is a previous version of Rumba installed?
• Will you need to uninstall a Rumba version?
• What type of installation will you select: Typical, Complete, or Custom?
• To which hosts will you connect: AS/400, Mainframe, HP or UNIX?
• Will you be using Intellimirror for your distributed installs?
• Will you be using SMS for your distributed installs?
• Will you be using SMS combined with Intellimirror?
• Will you customize the install with your own transforms?
• Will you be installing on Windows Terminal Server (Citrix)? If you are installing on Windows Terminal

Server, then have your Rumba license key for Terminal Server at hand. Having Rumba installed on the
Windows Terminal Server, follow its vendor instructions on how to publish Rumba applications to your
users.

Deployment strategies

As an administrator, how you deploy Rumba depends largely on the change and configuration
management functions of your networks, whether simple or complex. Installing, Modifying, Repairing, and
Uninstalling Rumba Software contains detailed deployment and customization information for your
enterprise-wide Rumba installations.

• License key

Each Rumba Edition is unlocked by an appropriate license key. The license key consists of a five-six-
five alphanumeric numbering system. This is located on your CD case. For example:

XXXXX-XXXXXX-XXXXX.

You may install Rumba Office Edition or evaluation without a license key. The installation will function
for 30 calendar days. When you do obtain a license key, Setup will validate the key and will allow
Rumba to run beyond the 30 day evaluation period.

Each license key is specific to a particular version of Rumba.
• Server path

When you are doing any kind of administrative install you need to know the UNC path of the distribution
point.

• Name and company name

The Name should be the name of the registered user of the Rumba software. The Company Name is
an optional field; some people prefer to use their department name.

• Typical, Complete, or Custom installation

These installation options allow you to control which Rumba features are installed. The available
features will change depending on your Rumba Edition.

• Typical: installs a standard set of Rumba features (but not every feature). This is the simplest
installation type.

• Complete: installs all Rumba features, without the opportunity to add or remove individual features.
• Custom: Gives you the opportunity to add or remove individual features.

Migration issues/Directory locations

Consequently, user-defined and configuration files no longer reside in the same locations as in Rumba
versions prior to 7.0. In order to support the roaming experience of Windows, we classify each of these
files according to their scope and function. Examples are:

Per user - each user has their own version of a file and this file can roam with the user. .
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Machine-specific - this file only relates to the machine that the product is currently installed on and cannot
roam with the user.

These locations are configurable.

See Rumba File Locations for Windows XP, and Rumba File Locations for Windows 7 and Vista.

Previous-version Rumba installations (pre-Rumba 7.0)

Rumba will detect the existence of previous 32-bit Rumba and On Web Web-to-Host products. The
installation will not continue until these have been removed. For large SMS deployments, it is strongly
advised that you create separate SMS packages for the removal of the old version of the product and the
installation of the new version.

For detailed information on Rumba file locations on supported platforms, consult Appendices B and C of
this document.

Registering Rumba (via the Web)

You have the option of registering Rumba at the beginning of the autorun installation process, directly from
the Setup splash screen. Registration is important because it allows you to get product support, technical
assistance, and qualify for software updates and other services.

Workstation and Administrative Installation

• Workstation installation

You can install to a workstation from a CD, or from an administrative install on a server.
• Administrative installation

You install Rumba to a network location for use by a workgroup. An administrative install uses the
msiexec command line option /a. Users with access to the location can install the product from this
source. For example:

msiexec /a rumba.msi [TARGETDIR=\\server\share\path [/qb]]

See Microsoft Installer Command Line Arguments.

The following table describes the differences between a simple administrative install and a workstation
install.

Table 13: Choosing between workstation and administrative installations

To install From CD From the server

Workstation (standalone) Run Rumba.exe or rumba.msi rumba.msi

Server Run an administrative install with the
command line option /a

N/A

Workstation N/A Run Rumba.exe from the Rumba
directory of the network server (or
adminstrator-specified location).

Microsoft Host Integration Server (HIS) 2000 Server and Client

To configure a workstation to communicate with a Microsoft HIS 2000 server (formerly called Microsoft
SNA server), you need to have two pieces of software on the workstation: the Microsoft HIS2000/SNA
client, and the Rumba interface for the Microsoft SNA/HIS 2000 server. If you do not have the software for
the Microsoft SNA client, you can download the client from Microsoft.
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Installing, modifying, repairing, and uninstalling Rumba
software

This section explains the installation process and contains procedures used to install and uninstall Rumba
software.

The following topics are discussed:

• The installation process (with the Microsoft Installation service)
• Installation rollback
• Modifying and repairing Rumba
• Procedures for uninstalling Rumba software

The installation process
Installation can be as simple as following the installation wizard on a single desktop, or as flexible as
"push" and "pull" delivery options with transforms.

To modify the basic installer process, you must have a competent grasp of how to create transforms, and
an authoring tool to do so, and/or are familiar with command line options.

You should already know what kind of installation you need and should already have gathered the
information required. If not, see Things to consider before installation.

Changes to Rumba components

The Rumba Optimized Server ODBC driver has been moved into the AS/400 File Transfer subsystem and
is installed automatically only if AS/400 file transfer is installed.

The TP Director was included in previous versions of Rumba to map Local LU 6.2 information for APPC
and/or CPIC Transaction Programs to a specific User ID. The TP Director is no longer installed as part of
Rumba, but can be installed separately from the CD if necessary.

Similarly, the Script Editor is no longer installed as part of Rumba but can be installed separately.

Installation setup
The first, and simplest, installation process consists of following the Rumba Setup wizard instructions.
During this installation process you will be asked to select a Typical, Complete, or Custom installation
option. The Typical installation option is the default.

Setup will:

• Transparently install the Windows Installer if it is not present on your system
• Transparently install the RSS Client (for increased security) if it is not present on your system
• Check that there is sufficient disk space on your destination drive
• Give you the opportunity to choose the product language (English, German or French)
• Advise you of any Rumba prerequisites that are not currently installed on your computer (C++ libraries

and/or .NET 3.5 SP1)
• Check that your license is valid
• Check your file permissions
• Modify your registry information
• Prompt you to reboot (if required)

Rumba as a stand-alone installation

To install on a stand-alone workstation:
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1. Double-click the Rumba .msi file.
2. Follow the instructions on the Setup wizard.
3. Enter the license key or install an evaluation version of Rumba. You can bypass the license key dialog

box by adding the license key to a command line. For example, rumba.msi LICENSEKEY=<your
license key>

For detailed information on command line syntax, see Microsoft Installer Command Line Arguments.
4. Review the Rumba license agreement. Select I accept the terms in the license agreement to

proceed.
5. Enter your Name and your department or Company Name.
6. Choose a directory for Rumba to be installed to. Micro Focus recommend that you use the default of C:

\Program Files\Micro Focus\Rumba. You can also choose the location for application data files:

a. Windows Default Folders. The default location where Windows saves application data.
b. Specify Private Folders. This allows you to set custom locations in which the User Profiles and

Interface Configurations will be stored.
7. Select the installation type: Complete, Custom or Typical.

• Complete. Installs all Rumba components. This option requires the most disk space.
• Custom. This option has the same default items selected as the Typical option, but allows you to

add or remove individual components. The Feature Description panel to the right of the component
selection box indicates the amount of disk space required for each feature.

• Typical. Installs a standard set of Rumba components. This is the simplest installation type. Note
that it does not install every component.

Setup creates a Micro Focus Rumba directory in your Windows Start menu from which you can access all
the Rumba products and related tools that you have installed.

Note: The items that Rumba adds to the Start Menu have changed since previous releases. In
particular, the Display and Printer items for different hosts are now all accessed from the single Micro
Focus Rumba Desktop 8.2 option.

Rumba as an administrative installation

Use the following command line syntax:

msiexec /a drive:\Rumba_English.msi [TARGETDIR=path [/q[b]]].

Rumba as a run-from-source installation

A run-from-source installation means that only a very small subset of files is installed on the user
workstation, and the bulk of the product is run directly from a central location, such as a shared network
drive. This approach minimizes local computer disk requirements but increases network load.

This type of installation is done in two stages:

• Stage 1 – Server installation that prepares files for use in the workstation installation.
• Stage 2 – Workstation installation.

The following procedure describes how to install the English version of Rumba. For other languages, use
the appropriate language version of the files.

Stage 1 – Server installation

1. Select the location for the run-from-source installation (RFS directory). This is usually a shared directory
on a network drive. To protect installation files, either specify read-only access to the directory for all
users, or individually change file attribute for all the installed files to read-only.

2. To create an administrative installation, run the following command line:

msiexec /a Rumba_English.msi

and specify the RFS directory as destination directory.
3. Create a transform (.mst) file using your preferred tool and copy it into the RFS directory.
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Stage 2 – Workstation installation

1. Run the following command line from the RFS directory:

msiexec /i Rumba_English.msi TRANSFORMS=<transform>.mst

Note: Install on Demand is not supported when using the run-from-source type of installation.

Default Path of User Profile

Regardless of the installation type, the default path for the User Profile and Interface Configuration Folders
is:

• Vista and Windows 7:

C:\Users\<UserLogon Name>\AppData\Local\Micro Focus\Rumba

• Windows XP:

C:\Documents and Settings\<UserLogon Name>\Application Data\Micro Focus
\Rumba

If OnWeb Web-to-Host is installed on the same computer, you cannot change the destination or user
profile folder location as many files are shared by both products.

Rollback

When you are in the process of installing Rumba in any configuration with Rumba Setup, the installation
process can completely rollback— that is, it will undo every operation that it performs during an install,
modification, repair, or removal. This is particularly helpful if you encounter a fatal error during an installer
session. The computer can return to the precise state it was in before the installer session. This includes
restoration of deleted or overwritten files, registry keys, and other resources.

You cannot roll back a completed Rumba installation. You will have to uninstall the program in order to
remove it.

Rollback disk space requirements

It is possible that the disk space requirement for installing a specific feature may be twice the size of the
net disk space consumption. Files that are deleted or overwritten during the course of an installation or
removal are temporarily saved to a backup location so that they can be restored if necessary. After a
successful installation, or installer operation, all temporary backup files are deleted.

Modifying, repairing or removing Rumba.

Modify

You can modify a Rumba installation by launching the Setup program, or clicking Change from Windows
Add/Remove Programs, and selecting the Modify option.

The Select Features dialog is the same dialog presented by the wizard during a Custom installation.You
can add or delete Rumba features during the Modify operation.

Repair

You can repair a Rumba installation using Windows Add/Remove Programs, by clicking Change and
selecting the Repair option from the Application Maintenance dialog.

The Repair option can:

• Determine whether the requested components and feature are installed. If a component and feature are
not installed the installer will check for missing files and reinstall.

• Check that all components in the requested feature are properly installed. The installer verifies the
keypath of a given component to determine if that component is broken. If the keypath resource is
missing, the installer will perform an on-demand repair.
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Remove

You can remove a Rumba installation using Windows Add/Remove Programs.

Ensure that the Rumba installation folder (normally C:\Program Files\Micro Focus\Rumba) was deleted
during removal. If not, it is safe to delete it manually.

Note: OnWeb Web-to-Host uses some of the same files as Rumba. If you also have OnWeb Web-to-
Host installed on your computer, the Rumba directory will not be removed and should not be manually
deleted.

Note: If you have other Micro Focus products installed on your computer, RSS Client files are not
removed during the uninstall process. Removing them could cause another Micro Focus product to
stop functioning.

Customizing Setup
This section contains information to help you customize your Rumba installation for individual, group and
enterprise-wide distributions:

The Custom option of the Rumba Setup wizard allows feature selection, is self-explanatory and easy to
understand.

You can create transforms (.mst) to modify the Rumba installation at installation time.

You can use Microsoft Installer command line arguments to alter the installation.

Deployment information with SMS is presented in “General SMS Deployment Requirements”.

How to customize Setup
There are several ways to specify custom changes to the standard operations and behavior of the Setup
program. Each of these methods affects a different aspect of the installation process. By combining them,
you can effectively distribute Rumba to make full use of Intellimirror features as well as SMS management
capabilities.

Transforms
A transform modifies the base installation package file at installation time. The transform remains cached
on the computer and is applied to the base installation package whenever the Windows Installer service
performs a configuration change (including repair) on Rumba.

Transforms cannot be applied to an already installed application, only at initial installation.

To create a transform, you will need an authoring tool. For additional information about types of transforms
and how to apply a transform to a Rumba installation, see “Transforms”).

The use of an authoring tool is necessary to create a transform for Rumba 8.2. It is recommended that
users apply these tools carefully as they expose a great deal of functionality and detail. Since each install
customized by an authoring tool is unique Micro Focus may not be able to support customers using such
installations.

Microsoft Installer command line arguments
The following information is available in more detail from the Microsoft Installer SDK. The most common
options and parameters are presented here to enable you to easily organize and customize your
deployment options.
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Option Parameters Definition

/i {package|ProductCode} Installs or configures a product:

For example, msiexec /i A:\rumba.msi
LICENSEKEY=<your license key>

/a package Administrative installation option.

/f [p][o][e][d][c][a][u][m][s][v]{package|ProductCode} Repairs a product. This option ignores any property
values entered on the command line.

p - Reinstall only if file is missing.

o - Reinstall if file is missing or if an older version is
installed.

e - Reinstall if file is missing or an equal or older
version is installed.

d - Reinstall if file is missing or a different version is
installed.

c - Reinstall if file is missing or the stored checksum
does not match the calculated value.

a - Force all files to be reinstalled.

u - Rewrite all required user-specific registry
entries.

m - Rewrite all required computer-specific registry
entries.

s - Overwrite all existing shortcuts.

v - Run from source and recache the local package.

As an example, repair an installation with the
following command:

msiexec /fpecms rumba.msi

/x {package|ProductCode} x - Uninstalls a product. For example:

msiexec /x rumba.msi

/L [i][w][e][a][r][u][c][m][p][v][+][!]logfile Specifies the path to the log file. The following flags
are:

i - Status messages

w - Nonfatal warnings

e - All error messages

a - Startup of actions

r - Action-specific records

u - User requests

c - Initial user interface parameters

m - Out-of-memory

p - Terminal properties

v - Verbose output

/p PatchPackage Applies a patch. To apply a patch to an installed
administrative image you must combine options as
follows:

/p - PatchPackage
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Option Parameters Definition

/a - package

/q {n | b | r | f} In conjunction with /i (install) or /x (uninstall), sets
the user interface level.

qn - No user interface

qb - Basic user interface

qr - Reduced user interface with modal dialog box
displayed at the end of installation.

qf - Full user interface with modal dialog box
displayed at end of installation.

qn+ - No user interface except for modal dialog box
displayed at end of installation.

qb+ - Basic user interface with modal dialog box
displayed at end of installation.

qb- - Basic user interface with no modal dialog
boxes.

Note: /qb+- is not a supported user interface level.
The modal dialog box does not display if the user
cancels the installation. The following command will
display the basic user interface options during
package installation:

msiexec rumba.msi /qb

Distributing Rumba with SMS
The mechanics of Microsoft Systems Management Server (SMS) administration are beyond the scope of
this document. It is assumed that you are familiar with the standard operations of the SMS family of
products.

The latest SMS product is System Center Configuration Manager 2007, which incorporates built-in support
for Microsoft Vista and Windows 7.

Uninstalling previous versions of Rumba
Before you can deploy this version of Rumba, you must uninstall any previous versions of Rumba that are
currently installed.

The easiest way to uninstall Rumba varies according to the version of SMS you have installed. In some
versions of SMS the easiest way to uninstall previous versions of Rumba is to include a response file
(response.ini) or definition file (.pdf) in a command line as part of an uninstallation deployment package. In
this case, if you do not have the previous-version documentation and the .pdf or response file (or files) of
your previous Rumba installation, you will need to create a new response file.

In other versions of SMS the easiest method is to create a Task Sequence to run the uninstallation. Check
the documentation for your SMS version.

Preparing client computers for Windows Installer
Once you’ve uninstalled a previous Rumba version you must ensure that Windows Installer is resident on
client computers before installing this current version of Rumba. If not, you must install it.
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Installing Windows Installer requires administrative rights on client computers. To install Windows Installer,
you can use the installer setup program, InstMSI.exe.

Note: Command line options are case sensitive.

You can also create a program dependency in an SMS deployment package which installs the Microsoft
Installer service immediately prior to a Rumba installation, on an on-demand basis.

You can download the Microsoft Installer SDK from: http://www.microfocus.com/docs/links.asp?nx=platsdk

Creating a Rumba deployment package
Before creating a Rumba deployment package, consider:

• Source and distribution points
• Will this be an on-demand installation?
• How your Collections should be configured
• Whether clients have the correct rights, or whether to configure Package Access Accounts
• Will you configure the user interface to be used by the clients?

You can use the SMS New Package Wizard to create a deployment package.

Identifying a package source directory
The directory that you perform an administrative installation to becomes the package source directory. Any
additional files, such as Rumba profiles or transforms, should also be copied to this location. The results of
the administrative installation plus any modifications you make will be propagated to the specified
distribution point servers. SMS clients can then install the package from the distribution point servers.

Advanced deployment issues
• System restarts

Because Rumba determines if a computer must be restarted at installation time, the safest option is to
assume you will need to configure SMS to perform the restart.

• Program removal

Rumba will be registered in Add/Remove Programs in the Control Panel. This allows the application to
be automatically removed using SMS.

http://www.microfocus.com/docs/links.asp?nx=sms

Transforms
Transforms increase the flexibility of Rumba installations by providing a way of applying changes to the
installation database without altering the original database. For example, in organizations where different
departments require different installations of Rumba, Rumba's base package can be made available to
everyone at one administrative installation point with the appropriate customizing transforms separately
distributed to each group of users.

You should become competent with a transform authoring tool in order to make full use of a Rumba
distribution on Windows 2000/XP and above. Information specific to authoring tools can be found in their
respective documentation.

http://www.microfocus.com/docs/links.asp?nx=win_inst_trans
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Rumba File Locations for Windows XP

Preinstalled Files

DEFAULT.MNC C:\Documents and Settings\All Users\Application Data
\Micro Focus\Rumba

SmpleAS4.rmc Program Files\Micro Focus\Rumba\AS400\Macro

smplehp.rmc Program Files\Micro Focus\Rumba\Hp\Macro

smpletso.rmc Program Files\Micro Focus\Rumba\MFrame\Macro

smpleVM.rmc Program Files\Micro Focus\Rumba\MFrame\Macro

smplevt.rmc Program Files\Micro Focus\Rumba\Vt\Macro

Run-created Files

Default.mnc C:\Documents and Settings\<USER>\Application Data
\Micro Focus\Rumba

CONFIG.EHN C:\Documents and Settings\<USER>\Application Data
\Micro Focus\Rumba

WDEvtLog.log C:\Documents and Settings\All Users\Application Data
\Micro Focus\Rumba

WDSNA.CFG C:\Documents and Settings\All Users\Application Data
\Micro Focus\Rumba

wdteldn.cfg C:\Documents and Settings\<USER>\Application Data
\Micro Focus\Rumba

wdtelnl.cfg C:\Documents and Settings\<USER>\Application Data
\Micro Focus\Rumba

Macros

.rmc C:\Documents and Settings\<USER>\Local Settings
\Application Data\Micro Focus\Rumba\as400\Macro

C:\Documents and Settings\<USER>\Local Settings
\Application Data\Micro Focus\Rumba\HP\Macro

C:\Documents and Settings\<USER>\Local Settings
\Application Data\Micro Focus\Rumba\MFrame\Macro

C:\Documents and Settings\<USER>\Local Settings
\Application Data\Micro Focus\Rumba\VT\Macro

User Toolbars

The user toolbars that were used in previous releases are now saved within individual Session Profiles and
cannot be shared.

Default Session Profiles

.prf C:\Documents and Settings\<USER>\Application Data
\Micro Focus\Rumba\Defaults
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User Session Profiles

.rsda C:\Documents and Settings\<USER>\Local Settings
\Application Data\Micro Focus\Rumba\as400

.rspa C:\Documents and Settings\<USER>\Local Settings
\Application Data\Micro Focus\Rumba\as400

.rsdh C:\Documents and Settings\<USER>\Local Settings
\Application Data\Micro Focus\Rumba\HP

.rsdm C:\Documents and Settings\<USER>\Local Settings
\Application Data\Micro Focus\Rumba\MFrame

.rspm C:\Documents and Settings\<USER>\Local Settings
\Application Data\Micro Focus\Rumba\MFrame

.rsdu C:\Documents and Settings\<USER>\Local Settings
\Application Data\Micro Focus\Rumba\VT

Desktop Profiles

.rdps C:\Documents and Settings\<USER>\Local Settings
\Application Data\Micro Focus\Rumba

Print Preview

.rpf C:\Documents and Settings\<USER>\Local Settings
\Application Data\Micro Focus\Rumba

Keyboard Map

.map C:\Documents and Settings\<USER>\Local Settings
\Application Data\Micro Focus\Rumba\AS400

C:\Documents and Settings\<USER>\Local Settings
\Application Data\Micro Focus\Rumba\HP

C:\Documents and Settings\<USER>\Local Settings
\Application Data\Micro Focus\Rumba\MFrame

C:\Documents and Settings\<USER>\Local Settings
\Application Data\Micro Focus\Rumba\VT

Transferred Files

? C:\Documents and Settings\<USER>\Local Settings
\Application Data\Micro Focus\Rumba\AS400

C:\Documents and Settings\<USER>\Local Settings
\Application Data\Micro Focus\Rumba\HP

C:\Documents and Settings\<USER>\Local Settings
\Application Data\Micro Focus\Rumba\MFrame

C:\Documents and Settings\<USER>\Local Settings
\Application Data\Micro Focus\Rumba\VT

Hotspots Library

.hsp C:\Documents and Settings\<USER>\Local Settings
\Application Data\Micro Focus\Rumba\as400\Macro
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C:\Documents and Settings\<USER>\Local Settings
\Application Data\Micro Focus\Rumba\HP\Macro

C:\Documents and Settings\<USER>\Local Settings
\Application Data\Micro Focus\Rumba\\MFrame\Macro

C:\Documents and Settings\<USER>\Local Settings
\Application Data\Micro Focus\Rumba\VT\Macro

Help Files

.chm English C:\Program Files\Micro Focus\Rumba
\MRI2924

French C:\Program Files\Micro Focus\Rumba
\MRI2928

German C:\Program Files\Micro Focus\Rumba
\MRI2929

Font Mapping File

.lcs C:\Documents and Settings\All Users\Application Data
\Micro Focus\Rumba

Rumba File Locations for Windows 7 and Vista

Preinstalled Files

default.mnc C:\ProgramData\Micro Focus\Rumba

SmpleAs4.rmc C:\Program Files\Micro Focus\Rumba\As400\Macro

SmpleHP.rmc C:\Program Files\Micro Focus\Rumba\Hp\Macro

SmpleTSO.rmc C:\Program Files\Micro Focus\Rumba\Mframe\Macro

SmpleVM.rmc C:\Program Files\Micro Focus\Rumba\Mframe\Macro

SmpleVT.rmc C:\Program Files\Micro Focus\Rumba\Vt\Macro

Run-created Files

default.mnc C:\Users\<USER>\AppData\Roaming\Micro Focus
\Rumba

config.ehn C:\Users\<USER>\AppData\Roaming\Micro Focus
\Rumba

RumbaTRC.CFG C:\Users\<USER>\AppData\Roaming\Micro Focus
\Rumba

Macros

.rmc C:\Users\<USER>\AppData\Local\Micro Focus\Rumba
\AS400\Macro
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C:\Users\<USER>\AppData\Local\Micro Focus\Rumba
\HP\Macro

C:\Users\<USER>\AppData\Local\Micro Focus\Rumba
\MFrame\Macro

C:\Users\<USER>\AppData\Local\Micro Focus\Rumba
\VT\Macro

User Toolbars

The user toolbars that were used in previous releases are now saved within individual Session Profiles and
cannot be shared.

Default Session Profiles

.prf C:\Users\<USER>\AppData\Roaming\\Micro Focus
\Rumba\Defaults

Desktop Profiles

.rdps C:\Documents and Settings\<USER>\Local Settings
\Application Data\Micro Focus\Rumba

Print Preview

.rpf C:\Users\<USER>\AppData\Local\Micro Focus\Rumba
\AS400

C:\Users\<USER>\AppData\Local\Micro Focus\Rumba
\HP

C:\Users\<USER>\AppData\Local\Micro Focus\Rumba
\MFrame

C:\Users\<USER>\AppData\Local\Micro Focus\Rumba
\VT

Keyboard Map

.map C:\Users\<USER>\AppData\Local\Micro Focus\Rumba

Transferred Files

? C:\Users\<USER>\AppData\Local\Micro Focus\Rumba
\AS400

C:\Users\<USER>\AppData\Local\Micro Focus\Rumba
\HP

C:\Users\<USER>\AppData\Local\Micro Focus\Rumba
\MFrame

C:\Users\<USER>\AppData\Local\Micro Focus\Rumba
\VT
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Hotspots Library

.hsp C:\Users\<USER>\AppData\Local\Micro Focus\Rumba
\AS400\Macro

C:\Users\<USER>\AppData\Local\Micro Focus\Rumba
\HP\Macro

C:\Users\<USER>\AppData\Local\Micro Focus\Rumba
\MFrame\Macro

:\Users\<USER>\AppData\Local\Micro Focus\Rumba\VT
\Macro

Help Files

.chm English C:\Program Files\Micro Focus\Rumba
\MRI2924

French C:\Program Files\Micro Focus\Rumba
\MRI2928

German C:\Program Files\Micro Focus\Rumba
\MRI2929

Font Mapping File

.lcs C:\ProgramData\Micro Focus\Rumba\
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Introducing Rumba
This section provides an introduction to Rumba.

Rumba features
Rumba software, the PC-to-host connectivity system, gives you easy, complete, and transparent access to
host applications. PC users working in the Microsoft Windows environment and using Rumba software can
communicate with a number of hosts and host applications.

Note: Which hosts you can connect to depends on which edition of Rumba you have installed. For
example, Rumba AS/400 Edition enables you to connect to AS/400 hosts.

Rumba software combines the convenience, ease of use, and versatility of PCs with the power of your
existing hosts and host applications.

This section provides an overview of the core capabilities of Rumba. You can find more specific information
in other sections of this guide (see What is in this guide).

Features summary
Rumba software takes full advantage of the Windows graphical user interface and tabbed browsing
capabilities. Together, these features help improve user efficiency and simplify the sharing and
manipulation of data among multiple PC and host platforms.

Using Rumba software, you can:

• Access multiple host sessions simultaneously from the same window
• Switch system keyboards as you do in Windows (ALT+SHIFT)
• Copy and paste data between tabs or windows
• Capture screen data to a file
• Copy information to the Windows Clipboard (including, in Rumba Mainframe Edition, the ability to copy

only unprotected fields)
• Rumba AS/400 Edition: Use long passwords to provide an additional authentication mechanism with

stricter encryption and tighter security
• Rumba UNIX Edition: Use the History feature to maintain a larger list of recently performed operations

and scroll back to them easily

Enhanced security through SSL/SSH

With the inclusion of SSL 3.0 (Secure Sockets Layer), TLS 1.0 (Transport Security Layer), and SSH
(Secure Shell) support, users can securely access applications and transfer data between their desktops
and host systems, encrypting the session data stream to a host capable of supporting these protocols.

Help topic: Connecting to a host > Connecting to an HP or UNIX host > Configuring the Telnet
interface

Host sessions

Rumba software runs on a single-user PC connected to a host, or on a local area network (LAN) with a
gateway connection to a host. Rumba Mainframe Edition software can also connect to a host using
multiple Physical Unit IDs (PUIDs) with a Token Ring or Ethernet® connection.From a single window, you
can run multiple host sessions using different connection types.
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You can also retrieve data from one or more hosts and transfer it to PC applications or print the data.

Rumba printer
Rumba AS/400 and Mainframe Editions support a wide range of printer features, including the ability to:

• Save and print host screens
• Print to a disk
• Route screen output to a LAN print server for shared printing
• Use international character sets

Copy and paste
Rumba provides full interoperability between your host applications and other Windows applications. As
well as normal copy and paste operations, you can use the Paste Link facility to automatically update the
data in a Windows application whenever both it and a Rumba session to the host are open.

File transfers
The file transfer feature copies files between your PC and the host. Rumba software allows you to navigate
through the host file system, listing host and PC directories to simplify file selection and transfer. When you
select the Rumba Initiated File Transfer feature, Rumba software automatically starts the file transfer
program on the host and sends or receives the file.

AS/400 file transfer

There are two ways to run file transfers from an AS/400 Display session:

• AS/400 File Transfer.

This method sends data between the host and your PC. If the AS/400 host is not in passthrough mode,
the Send and Receive commands on the Transfer menu will open the AS/400 File Transfer window.

• Mainframe Passthrough.

This method uses the AS/400 as an emulator to transfer files to and from a mainframe host. You must
first connect Rumba to the AS/400, then run the emulator program on the AS/400 to connect to the
mainframe. Rumba software detects the passthrough state of the AS/400, so you can use the Send and
Receive commands on the Transfer menu to transfer files between the mainframe host and your PC.

Mainframe file transfer

The file transfer feature copies files between your PC and the mainframe. The Send and Receive
commands on the Home menu (the Transfer menu if using Rumba’s Classic interface) open a setup
window where you specify the file type, transfer protocol, and host environment for the file transfer. You
can also choose to have Rumba software initiate the file transfer protocol. The mainframe file transfer
feature works transparently with SimXfer and most IBM host operating systems, including CICS, TSO, and
VM/CMS.

The mainframe file transfer also provides abundant functionality such as support for ASCII or binary
transfers, Write Structured Field or Buffered data streams, EBCDIC-to-ASCII translation, and data
compression. Rumba software also supports DOS-based, batch, and drag-and-drop file transfer features.

User interfaces

This version of Rumba provides two different versions of the user interface. You can switch between these
at any time according to your personal preferences.

• Ribbon. Originally introduced by Microsoft Office 2007, this interface organizes commands into a
‘ribbon’ across the top of the application window. The commands shown change according to the tab
that has been selected. This makes application features easier to find and quicker to use.

• Classic. An interface similar to that used in previous versions of Rumba, for users experienced with
older versions of Rumba.
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Screen displays
Rumba software takes full advantage of the GUI capabilities of Windows to offer these features:

• Support of alternate screen sizes, adjusting the host application to fit within the window
• Simultaneous display of applications in a variety of screen sizes without reconfiguring your PC software

or modifying the host application
• Customization of screen color schemes for existing host applications

Note: Rumba Mainframe Edition supports alternate screen sizes for IBM models 2, 3, 4, and 5

International keyboards
Rumba software supports international PC and host keyboards, such as French, German, Norwegian,
Swedish, Danish, Spanish, and Italian.

Rumba software supports most types of PC keyboards (for example, the PC, AT, and Enhanced 101- and
102-Key). If you do not find your keyboard on the supported list, contact Micro Focus technical support.

You must install the appropriate keyboard driver (usually supplied with the keyboard or an international
version of Windows) using the Windows Setup option.

Supported VT features
Rumba software supports configuration of VT features and options through the keyboard, tool bar, and
menus. Features available to you when using a VT terminal and keyboard are available from your PC
using Rumba software. See Appendix B: VT Keyboard Key Codes for a complete listing.

Rumba software emulates the following VT terminal types:

• VT52
• VT100
• VT101
• VT125
• VT220
• VT240
• VT241
• VT320
• VT330
• VT340
• VT420 (paging available; default if VT340 not installed)
• 401x (Tektronix graphics, includes 4010/44014; automatic font adjustments occur when entering this

mode)
• BBS ANSI
• SCO ANSI
• WYSE 50/60

You can select and configure the terminal you want to emulate.

Supported HP features
Rumba software supports configuration of HP features and options through the keyboard, tool bar, and
menus. Features available to you when using an HP terminal and keyboard are available from your PC
using Rumba software.

Rumba software emulates the following HP terminal types:

• HP70092
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• HP70094
• HP70096
• HP70098
• HP2392A
• HP2394A

You can select and configure the terminal you want to emulate.

Automating your work
Rumba provides several powerful tools for automating host communications tasks.

• Macros

Rumba macros are used to automate simple tasks such as logging on, copying and pasting text
between Rumba Display windows and applications such as Microsoft Excel, or sending a sequence of
commands to the host. You can configure and use Rumba macros in a variety of ways, including:

• Auto macros

You can save a macro as a connect or disconnect macro: a macro that automatically performs a task
such as logging on or off each time you open or close the session profile in which it was created.

• Scripts

The separate Rumba Script Editor application provides more complex and powerful automation options
than the Macro Editor. You can use scripts to automatically reconfigure the user interface, perform
random access file operations, automate tasks, modify functionality, and handle incoming events.

Where provided, the Rumba Script Editor can be installed by double-clicking ScriptEngine.msi.

Configuration files
User configuration files (profiles) are stored in the My Documents folder (or the Personal folder in
Windows 7 or Vista), while configuration interfaces are stored in the Application Data folder.

Rumba folders
From Start > Programs > Micro Focus Rumba , you can access your Rumba programs, including the
Rumba Administrative Tools folder. Exactly what programs are available depends on which components
you installed.

The Rumba Administrative Tools folder contains tools for system administrators, such as:

• Micro Focus Rumba 8.2 APPC Configuration
• Micro Focus Rumba 8.2 AS400 Communications
• Micro Focus Rumba 8.2 Comunication Monitor
• Micro Focus Rumba 8.2 Engine
• Micro Focus Rumba 8.2 Submit Remote Command
• Micro Focus Rumba 8.2 Trace

Using Rumba menus, toolbars, and the status bar
You can use Rumba software’s commands, either from the Classic or the Ribbon interface, to perform
most of your host tasks. The status bar provides you with information about Rumba software and the state
of the host.

You can streamline your work environment by customizing your Rumba menus and toolbar. For example,
you can add icons to launch external applications, or remove menu commands and toolbar buttons that
you do not use. Currently, this facility is only available for the Classic interface.
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Help section: Introduction > Working with toolbars and menus

Customizing menus and toolbars
To customize the commands available within a profile:

1. Open the Rumba display or printer session containing the menus that you want to change.

2. Choose the Toolbars option from the View menu.
The Customize dialog box opens.

3. Use the Toolbars page to create and rearrange custom toolbars with the commands you use most
often. Use the Commands page to add commands to the standard toolbar or to change the availability
of commands within the interface.
If you make the View > Toolbars command unavailable, you will not be able to make further changes.

4. On the Commands page, select Rearrange Commands > Modify Selection > New Button to create
new toolbar buttons of different types.

Toolbars can be docked, undocked and floated. They can also be imported from and exported to files.
Toolbar buttons can be chosen from several types.

Status bar
AS/400 status bar

Status bar area Function

Description area • Connected: The status of the host connection. If the host is not connected, the
description area is blank.

• Toolbar button function: If the mouse cursor points to a toolbar button, the
description area displays a description of the function performed by the toolbar
button.

• Menu command function: If the context-sensitive help cursor points to a menu
command, the description area displays a description of the function performed by
the menu command.

SA System available. When lit, this indicates that the host is operating and available to the
PC.

MW Message waiting. When lit, the host has one or more messages waiting for you.

KS Keyboard shift. When lit, the keyboard is in shift mode.

IM Insert mode. When lit, insert is on. Characters can be inserted into a field without
typing over the existing data.

II Input inhibited. When lit, keyboard input is not being accepted by the AS/400. Try
pressing the Error Reset key. If it is still highlighted, the system is processing your
request.

KB Keyboard buffer. This indicator is only displayed when you are waiting for the Input
Inhibited indicator to go off so that keystrokes that are buffered can be processed. To
clear keystroke buffering, press the Error Rest key.

Session Name Displays the name of the server to which the Rumba session is connected.

Cursor coordinates Lists the row and column position of the cursor.

Clock Displays the time.

HP status bar
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Status bar area Function

Communications interface Displays the communications interface you have selected, the server name (if
applicable), and whether or not the session is connected to the host.

Terminal type Shows the type of terminal this session is emulating, and other kinds of status
information applicable to the terminal. Information appears if the terminal is in hold or
wait conditions or if it is off-line.

Cursor coordinates Lists the row and column position of the cursor.

Clock Displays the time.

Mainframe status bar

Status bar area Function

Status field Displays general Rumba software status information.

Operator Indicates the operator's application session owns the screen.

SSL Indicates whether your session uses an SSL (Secure Sockets Layer) connection. This
field applies only to TCP/IP connections.

APL Indicates whether or not the host is in APL mode.

NUMFLD Indicates whether or not the cursor is currently in a numeric field.

LU# Shows the Logical Unit (LU) number.

OVR Indicates whether Overstrike or Insert mode is chosen.

CAP Indicates whether Caps Lock is on or off.

NUM Indicates whether the Number Lock is on or off.

W Indicates whether Word Wrap is on or off.

Cursor coordinates Lists the row and column position of the cursor.

Clock Displays the time.

UNIX status bar

Status bar area Function

Communications interface Displays the communications interface you have selected, the server name (if
applicable), and indicates whether or not the session is connected to the host.

Terminal type Shows the type of VT this session is emulating, and other kinds of status information
applicable to the terminal. Information appears if the terminal is in hold or wait
conditions, is off-line, or if you are composing a character sequence.

Cursor coordinates Lists the row and column position of the cursor. If you are using VT420 emulation, it
also indicates the page number.

Numeric/ Application mode Toggles the state of the terminal's numeric keypad between numeric mode and
application mode (which is not the same as the PC NUMLOCK feature).

Clock Displays the time.

Rumba Session Profiles
A Session Profile is a special configuration file used to store your settings for a specific session. You can
customize the settings for a particular host connection to meet your particular needs and preferences, then
save your settings in a Session Profile. When you open the profile, the Rumba session is configured with
settings you designate.

Session Profiles also provide a method for easily deploying standardized Rumba sessions to users. You
can create Session Profiles for customized host display and printer sessions.
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All Session Profiles are stored in a subfolder of the Application Data folder. For example, an AS/400 profile
would be stored at:

• Windows 7:

C:\Users\<user>\AppData\Local\Micro Focus\Rumba\AS400

• Windows Vista:

C:\Users\<user>\AppData\Local\Micro Focus\Rumba\AS400

• Windows XP:

C:\Documents and Settings\<user>\Local Settings\Application Data\Micro Focus
\Rumba\as400

The subfolders are named as400, HP, Mframe and VT (for UNIX host session profiles).

Note: Each Session Profile will open as a separate tab in the Rumba Display. This gives you the
flexibility of being able to open several different profiles in one window. You can save multiple
sessions in one configuration file as a Desktop Profile.

About Session Profiles
Session Profiles contain specific information about the Rumba session including:

• Interface selection and configuration
• Display settings including color, font and status bar options
• Keyboard maps and alternate character set selection
• Macros and script information (if the Script Editor is installed)

When you change your Rumba environment, you can save those changes in a new or existing profile.
Rumba software stores Session Profile data in a binary format.

Session Profiles are host-specific. The file extension for the different hosts are as follows:

Host File extension

AS/400 Display .rsda

AS/400 Printer .rspa

HP .rsdh

Mainframe Display .rsdm

Mainframe Printer .rspm

UNIX .rsdu

Note: You can use the Profile Editor to create and edit Rumba profiles . The Profile Editor is an OLE
control that you can load into your Visual Basic application. To install this utility, you must run a
complete installation, or run a Custom installation and select System Options/Administrator Options/
Profile Editor Control.

Supplemental and interface configuration files
There are also supplemental files that work together with the session profiles. These supplemental files
contain configuration or other important data unique to a feature. For example, the hotspot.hsp file is a
supplemental file. It is also a Hotspot file, and it contains all the data required to run a series of predefined
keystrokes.

Interface configuration files are a special class of supplemental files. They are saved in separate files with
the .cfg extension. You may have more than one of these interface files if you use multiple host
connections.
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For details on the locations of these files, see Installing Rumba.

The supplemental files and their default extensions are:

Table 14: Supplemental files and extensions

File type Extension

Interface configuration .cfg

Keyboard Map .map

Macro Script .rmc

Hotspot .hsp

Menu configuration .mnc

Script .csf and .vba

Toolbar .rtbr

Migrating Session Profiles from Rumba 6.x or 7.x
Session Profiles that were created using Rumba versions 6.x or 7.x can be migrated to Rumba 8.2. To do
this:

1. Open the profile in Rumba in 6.x or 7.x.

2. Click Tools > Menu , and select the Preview tab.

3. Ensure that the Gray disabled items option is selected.

4. Save the profile.

5. Upgrade to Rumba 8.2.

Rumba Desktop Profiles
A set of multiple Session Profiles can be saved as a single Rumba Desktop Profile. This allows you to
provide a standard set of tabbed sessions to your users, minimizing the amount of configuration needed for
each individual user.

By default, Rumba Desktops are stored with the file extension .rdps in the following folder:

Windows XP:

C:\Documents and Settings\<user>\Local Settings\Application Data\Micro Focus
\Rumba

Windows Vista and Windows 7:

C:\Users\<user>\AppData\Local\Micro Focus\Rumba

About Desktop Profiles
Desktop Profiles contain specific information about a Rumba instance, including:

• The set of Session Profiles used and their layout
• Any customized tab names
• Any vertical and horizontal tab groups

A Desktop Profile does not contain any information about which Rumba interface is used. All Desktop
Profiles may be opened in either the Classic or the Ribbon interface.
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Session Profile locations
A Rumba Desktop Profile contains references to the locations of all the Session Profiles that it includes.
The locations of any Session Profiles that are in a different folder to the Desktop Profile are stored as
absolute paths. If a Desktop Profile is to be deployed on machines other than the one on which it was
saved, all of the relevant Session Profiles should be contained within the same folder as the Desktop
Profile.

HP keyboard key codes
The HP keyboard sends a predefined escape sequence for each of its special keys (for example, editing
keys and numeric keys). Most applications written for use with HP terminals are expecting to use these
escape sequences. If your application is looking for a different escape sequence, you can program this
sequence to a keyboard string and map that keyboard string to a key sequence on your PC.

The tables in this appendix list the codes sent for each of the defined keyboard keys.

Keys mapped to default settings
Table 15: Keys mapped to activate default softkeys

Legend Key number*

Line modify F1

Modify all F2

Block mode F3

Remote mode F4

Type ahead F5

Memory lock F6

Display function F7

Auto line feed F8

*F1 through F8 are local function keys that do not send codes, except when configured to do so. These
keys are mapped to activate default softkeys. To see the key mappings, select SoftKeys from the Options
menu in the HP Display. In the SoftKeys Settings dialog box, click User Defined.

Keys used to send 7-bit control characters
Table 16: Keys used to send 7-bit control characters

Control character mnemonic ASCII value Key pressed with Ctrl (all modes)

SOH 1 A

STX 2 B

ETX 3 C

EOT 4 D

ENQ 5 E
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Control character mnemonic ASCII value Key pressed with Ctrl (all modes)

ACK 6 F

BEL 7 G

BS 8 H

HT 9 I

LF 10 J

VT 11 K

FF 12 L

CR 13 M

SO 14 N

SI 15 O

DLE 16 P

DC1 17 Q *

DC2 18 R

DC3 19 S *

DC4 20 T

NAK 21 U

SYN 22 V

ETB 23 W

CAN 24 X

EM 25 Y

SUB 26 Z

*: 7-bit control codes sent only when XON/OFF support is off.

Codes sent by editing keys
Table 17: Codes sent by editing keys

Key Code sent

Delete char ESC P

Insert line ESC L

Delete line ESC M

Insert char ESC Q

Prev char ESC V

Next ESC U

Clear line * ESC K

Clear display ESC J

To view these codes, select Show Host Keyboard from the Tools menu in the HP Display.
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These codes are only sent when Transmit Escape Sequences to Host is enabled. To enable this, select
Terminal from the Options menu in the HP Display. On the Advanced tab, click Transmit Escape
Sequences to Host.

Codes sent by arrow keys
Table 18: Codes sent by arrow keys

Key Cursor mode Application mode

Up ESC A ESCA

Down ESC B ESCB

Right ESC C ESCC

Left ESC D ESCD

These codes are only sent when Transmit Escape Sequences to Host is enabled. To enable this, select
Terminal from the Options menu in the HP Display. On the Advanced tab, click Transmit Escape
Sequences to Host.

Codes sent by numeric keypad keys
Table 19: Codes sent by numeric keypad keys

Key Numeric Application

0 0 ESC Q Ins

1 1 ESC F End

2 2 ESC B Down

3 3 ESC U PgDn

4 4 ESC D Left

5 5

6 6 ESC C Right

7 7 ESC h Home

8 8 ESC A Up

9 9 ESC V Pg Up

- (minus)

, (comma)

. (period) ESC P Del

Enter CR LF

Note: Character mode: code goes directly to host. Format/Block mode: code goes to host only when
user presses ENTER.

VT keyboard key codes
The VT keyboard sends a predefined escape sequence for each of its special keys (for example, function
keys, editing keys, and numeric keys). Most applications written for use with VT terminals expect to see
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these escape sequences. If your application is looking for a different escape sequence, you can program
this sequence to a keyboard string and map that keyboard string to a key sequence on your PC.

The tables in this appendix list the codes sent for each of the defined keyboard keys.

VT codes sent by top-row function keys
Table 20: VT codes set by top-row function keys

Legend Key number Code sent

Hold F1 * CSI 11~

Print F2 * CSI 12~

Set-Up F3 * CSI 13~

Session F4 * CSI 14~

Break F5 * CSI 15~

F6 F6 CSI 17~

F7 F7 CSI 18~

F8 F8 CSI 19~

F9 F9 CSI 20~

F10 F10 CSI 21~

F11 (ESC) F11 CSI 23~

F12 (BS) F12 CSI 24~

F13 (LF) F13 CSI 25~

F14 F14 CSI 26~

Help F15 CSI 28~

Do F16 CSI 29~

F17 F17 CSI 31~

F18 F18 CSI 32~

F19 F19 CSI 33~

F20 F20 CSI 34~

* : F1 through F5 are local function keys that do not send codes, except when configured to send codes.
To see the assigned local keys in the UNIX Display, select Terminal from the Options menu and click the
Key Assignments tab.

VT keys used to send 7-bit control characters
Enter the syntax information of your reference here (optional).

Control character mnemonic ASCII Value Key pressed with Ctrl (all modes)

SOH 1 A

STX 2 B

ETX 3 C
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Control character mnemonic ASCII Value Key pressed with Ctrl (all modes)

EOT 4 D

ENQ 5 E

ACK 6 F

BEL 7 G

BS 8 H

HT 9 I

LF 10 J

VT 11 K

FF 12 L

CR 13 M

SO 14 N

SI 15 O

DLE 16 P

DC1 17 Q *

DC2 18 R

DC3 19 S *

DC4 20 T

NAK 21 U

SUN 22 V

ETB 23 W

CAN 24 X

EM 25 Y

SUB 26 Z

* 7-bit control codes sent only when XON/OFF support is off.

VT codes sent by editing keys
Key Code sent

Find CSI 1~

Insert here CSI 2~

Remove CSI 3~

Select CSI 4~

Prev CSI 5~

Next CSI 6~
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VT codes sent by arrow key
Key Cursor mode Application mode

Up CSI A SS3A

Down CSI B SS3B

Right CSI C SS3C

Left CSI D SS3D

VT codes sent by numeric keypad keys
Numeric keypad mode setting (DECNKM), ANSI mode

Key Numeric Application

0 0 SS3 p

1 1 SS3 q

2 2 SS3 r

3 3 SS3 s

4 4 SS3 t

5 5 SS3 u

6 6 SS3 v

7 7 SS3 w

8 8 SS3 x

9 9 SS3 y

- (minus) SS3 m

, (comma) SS3 l

. (period) SS3 n

ENTER CR or CR LF * SS3 M

PF1 SS3 P SS3 P

PF2 SS3 Q SS3 Q

PF3 SS3 R SS3 R

PF4 SS3 S SS3 S

*Keypad numeric mode. ENTER sends the same codes as RETURN. You can use line feed/new line mode
(LNM) to change the code sent by RETURN. When LNM is reset, pressing RETURN sends one control
character (CR). When LNM is set, pressing RETURN sends two control characters (CR, LF).
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AS/400 Getting Connected
This section introduces the capabilities common to all Rumba AS/400 Display and Printer products.

While this section provides an overview of the core Rumba AS/400 Display and Printer connection
capabilities, you can find more information specific to file transfer and other AS/400 connection options in 
Configuring the AS 400 Communications Utility, and in AS/400 Client Application Guide.

Who should read this section
This section was written to help system administrators configure and maintain Rumba AS/400 Display and
Printer connections. It contains concise host-specific information. For in-depth information, see the pointers
to the appropriate location in the Rumba online help.

When you need advanced configuration settings
The APPC Configuration utility assists you in building a configuration file for the Rumba SNA engine. This
configuration file defines the elements: connections, AS/400 modes, remote and local logical units, CPI-C
side information file, transaction programs, and conversation security.

Making the connection
Today’s computer systems are made up of many different hardware and software components. To
maximize the value and effectiveness of these systems, Rumba AS/400 software offers a variety of
connection alternatives that allow you to connect to a host using twinaxial cables, through modems, or as
part of a local area network (LAN).

This section will help you to understand the nature of this relationship.

Note: The focus of this section is on connecting with the Rumba AS/400 Display and Printer.
Configuring connections for features such as AS/400 File Transfer and Shared Folders use the
Rumba AS/400 Communications dialog box. For more information on this application, refer to 
Configuring the AS/400 Communications Utility.

Overview of connecting
There is more to connecting to a host than just having the physical elements in place. When you use
Rumba AS/400 software, you create a specific relationship between the host link and the interface options
you configure.

The first time you make the host connection, you define these relationships following the steps outlined in
the next section, Connecting to the host. Thereafter, Rumba AS/400 software uses your customized
parameters to configure the new session environment for you.

Connecting to the host
The connection procedures in this appendix provide an overview of the process of the tasks you must
complete in order to configure an AS/400 interface for the first time.

To access the AS/400 Communications Utility for file transfers:
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• Click Start, then point to Programs > Rumba , and choose AS400 File Transfer.

To access the AS/400 Communications Utility for client applications:

• Click Start, then point to Programs > Rumba > Rumba Administrative Tools , and click Rumba
AS400 Communications.

Connecting the Connection Utility to the host involves the following tasks once you are at the Rumba
AS/400 Communications dialog box.

1. Click the Interface tab.
2. In the Installed Interface box, select an interface.
3. Click Configure, then configure the interface.

Use the four tabs of the Rumba AS/400 Communications dialog box to configure your connection for
different types of interfaces, set security options, support an array of character sets, and display error
messages for diagnostic purposes.

Starting the connection process
The General tab on the Connection Configuration dialog box is your starting point in configuring an AS/400
host connection. The name and number of additional tabs that are displayed depends on which interface
you choose.

The name of the interface currently selected appears on one tab (for example Rumba Router), and for all
but the TN5250 and Demo host interfaces, a Security tab is displayed as well.

Procedures for configuring each interface are described in the online help.

The Demo host
The Demo host lets you communicate with a simulated host through a series of PC-to-host conversations
previously recorded with the Data Stream Analyzer (DSA) Trace system.

When you use this host, Rumba software actually sends commands to a program emulating a host. The
host program responds with the corresponding 5250 data stream segments based upon your keyboard or
mouse input.

The Demo host is especially useful for training purposes. You do not have to configure the host or the
session parameters to use the demo host.
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Important: These fields are initialized with defaults based on data from your current profile if
available, or from system defaults. They are the recommended settings and should not be changed
except for special circumstances. Selecting an inappropriate starting state could result in undesirable
Demo Host behavior.

Selecting an interface
In establishing a host connection, you will need to determine which interface to use. The following table
outlines four network topologies. By matching your network topology with one of the examples in the first
column, you can begin the task of choosing the most appropriate interface.

In establishing a host connection, your first task will probably be to determine which connection protocol to
use. The following table outlines the connection protocol categories. By matching your network setup with
the simplified topology examples in the first column, you can begin the task of choosing the most
appropriate connection interface.
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LAN Direct is used when the LAN is directly connected to a host. Examples of this connection type are
listed below:

• MPTN (SNA over TCP/IP) *
• TN5250
• LAN Gateway

Using a LAN Gateway connection, the LAN is connected first to a gateway; usually for protocol conversion.
IPX and NetBIOS are two examples of protocols that require gateways, because neither are native to
normal host environments. An example of this connection type is:

• Microsoft SNA Server

Note: Interfaces marked with an asterisk are Rumba Router link types.

Configuring the interface
Having determined which interface best suits the needs or constraints of your connection requirements and
network topology, you need to provide information to Rumba software about how to find your host and how
your host can find you (the client).

You communicate all of this information via the tabs on the Connection Configuration dialog box. For the
majority of the fields used to specify client and host data, leaving the settings at their default values is the
best initial approach.

The process of specifying connection configuration parameters varies somewhat depending on the
interface you select. For the Rumba Router link types, the Rumba Router tab displays additional tabs that
make it possible for you to specify configuration values.
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Successful connection indicator
Once your host connection is established, the status bar’s description area will read “Connected.” When
the cursor is moved around the screen, the description area shows the last command selected. The status
bar displays SA (system available) in the first status box to indicate that the AS/400 is ready to respond.

Other helpful features
In addition to the connection methods already discussed, Rumba software has additional functions
designed to save you time, make the connection task easier, and help you understand the entire process
better.

The administrator override file

A high priority for any system administrator is the standardization of system configurations. When you
create an administrator override file, you provide a set of well-defined parameters that each user can
access. This tool can significantly reduce the time spent setting up and troubleshooting workstations.

An administrator override file is a configuration file you create and then place on the network. Your users
can access this administrator override file for connection information to SNA-type machines. If the
connection information changes, you can use the administrator override feature to make one central
change.

Using the Rumba Router to configure an APPC link
The Rumba Router supports Advanced Peer to Peer Networking (APPN), and the Common Programming
Interface for Communications.

(CPI-C). Workstations using the Rumba Router can connect to AS/400s over a LAN or direct physical
connection.

This section provides an overview of the procedures used to specify the settings for a host connection
using the Rumba Router.

Overview of Rumba Router
Using the Rumba Router provides you with support for a wider range of client-based applications and
connectivity types. By processing API commands on the client workstation, Rumba Router takes
advantage of the benefits of distributed computing to enhance both the performance and flexibility of the
applications you use to interact with your AS/400 host.

There are common elements within both the Connection Configuration and Link Configuration dialog
boxes, regardless of which Rumba Router link type you use to make a connection. Because of this,
specifying settings does not vary on the Rumba Router and Security tabs (on the Connection Configuration
dialog box) nor on the AS/400 Link and Advanced tabs (two of three tabs on the Link Configuration dialog
box).

When you select the Rumba Router, the Connection Configuration dialog box displays the Rumba Router
tab and the Security tab, in the second and third tab positions.

When you click the Rumba Router tab and add a new connection, you see the Link Configuration dialog
box. The Link Configuration dialog box has three tabs:

• the first is always AS/400 Link
• the second one changes to name the link type that you select
• the third is always Advanced
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Connection Configuration dialog box
Workstation users normally use this method rather than the Rumba APPC Configuration utility or the
Rumba AS/400 Communications utility to configure the connection from an AS/400 display or printer
session. The Rumba APPC Configuration utility is more suited for creating configuration files for SNA
interfaces, and the Rumba AS/400 Communications utility is used to configure host connections for Rumba
Client Applications.

The installed interfaces that display on the Connection Configuration dialog box include the Demo host,
Rumba Router, TN5250, and Microsoft SNA Server (if the SNA client is installed).

Setting up the connection
Setting up connections with the Rumba Router generally involves these three steps:

1. Configure the Rumba Router interface.
2. Choose a link or connection type.
3. Configure the link type.

Because the settings you can specify vary so widely depending on which link type you choose, each link
type is discussed in its own section. The Rumba Router and Security tabs do not change for each link type.
The remainder of this section outlines what you can specify with these tabs.

Rumba Router tab
This section lists and describes the parameters on the RUMBA Router tab on the Connection Configuration
dialog box.
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Parameter Name Description

AS/400 Information group Use this group box to select or edit an existing
configuration, or add a new configuration to the System
Name list. Configurations are not displayed in the System
Name list until you have added them.

System Name Lists all the currently configured systems. Click the down
arrow to select a system.

Set Default Designates the selected system as your default
connection, which will be used automatically unless
another system is selected before connecting. The
Default System is displayed in the System Name list with
an asterisk *.

Add Configures a new connection. The new connection will be
displayed in the System Name list after you have added
it.

Remove Deletes a configured connection. If you delete the default
system, then you will need to select or configure a new
system before connecting.

Properties Opens the Link Configuration dialog box for the selected
connection. You can edit the available parameters and
save the changes to the configuration.

Session Information group options Use the controls in this group to specify how user
information for this session is specified.

Auto sign-on When you check this box, your connection information is
used for the host sign-on.

Device Name You can add an optional device name that will override
the default device name used for this session.

In most cases, the device name defaults to your PC
System Name followed by S1 or P1. Instead of using the
default, you may enter a device name by which the
AS/400 will recognize this session.

PC Information group options Lists the information that will be used when connecting
your PC with the AS/400.

PC Name Add the name you use to log on to your network. This
corresponds to the controller ID configured on the AS/
400, and can be up to eight characters, including A-Z,
0-9, @, #, and $.

Network Name Add the name of the network you are connecting over.
For example, you may be using APPN.

On the AS/400 this corresponds to the Local Network ID,
and can be up to eight characters, including A-Z, 0-9, @,
#, and $. This identifies the AS/400 on the network.

You can find step-by-step procedures for configuring individual interfaces and link/connection types in the
online help.

The interface help files are a self-contained unit with information on requisite stacks, configuration
procedures, and troubleshooting information (including most error messages associated with an interface).
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When necessary, the help also assists you in locating values for interface parameters defining the local PC
and the remote host.

Security tab
This section lists and describes the parameters on the Security tab on the Connection Configuration dialog
box.

Parameter Name Description

Use Common Sign-on Uses the specified User ID and Password as sign-on
information for all systems.

AS/400 Sign-ons Lists the currently known AS/400 systems you have
configured security settings for. You must add systems
on the Interfaces tab before you can configure security
settings for them.

Add Sets up security for a new system.

Change Changes the security settings for the selected system.

Delete Deletes the security settings for the selected system.

Enable caching of User IDs and passwords Enables the storing of the User ID and password for the
currently configured system until you reboot your PC. If
you choose Enable caching of User IDs and passwords,
you will not have to enter your User ID and password for
subsequent connections unless you reboot.

Rumba Router link types
To configure an AS/400 Rumba Router link, you access the Link Configuration dialog box via the Rumba
Router tab of the Connection Configuration dialog box.

Connection Configuration dialog box
Workstation users normally use this method rather than the Rumba APPC Configuration utility or the
Rumba AS/400 Communications utility to configure the connection from an AS/400 display or printer
session. The Rumba APPC Configuration utility is more suited for creating configuration files for SNA
interfaces, and the Rumba AS/400 Communications utility is used to configure host connections for Rumba
Client Applications.

The installed interfaces that display on the Connection Configuration dialog box include the Demo host,
Rumba Router, TN5250, and Microsoft SNA Server (if the SNA client is installed).

AS/400 Link tab

The Link Configuration dialog box AS/400 Link tab is shown in the following illustration.
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This section lists and describes the parameters on the AS/400 Link tab on the Connection Configuration
dialog box.

Parameter Name Description

System Name Displays the alias for the AS/400. This name will be
added to the list of configured connections on the Rumba
Router tab.

For example, if you are connecting to a computer named
S1001234, you could call the computer Bill instead of
S1001234. By default, this name will be used as the LU
Name on the Advanced tab, though you can change this
at any time.

To change the System Name, or other connection
parameters later, select it from the System tab, and then
click Properties. If you are going through an adjacent
network node (system) via an APPN connection to
another system, enter the name of the target system.

Link Type Displays the link types you can connect over. You must
select a link type to complete the connection
configuration.

Your choice of link type will depend on your hardware
and software configuration, as well as the type of
connection you need. If you do not know which link type
to use, check with your system administrator.

Advanced tab

The Link Configuration dialog box Advanced tab is shown in the following illustration.
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This section lists and describes the parameters on the Advanced tab of the Link Configuration dialog box.

Parameter Name Description

LU Name Displays the name of the AS/400’s Logical Unit. This is
not an alias. This is the actual name of the AS/400, and
will be used to make the connection. The LU Name
corresponds to the System Name on the Rumba Router
tab. The System Name, however, can be an alias, while
the LU Name is always the actual name of the AS/400.

This name can be up to eight characters, including A-Z,
0-9, @, #, and $.

Network Name Identifies the network you are connecting over. The
Network Name corresponds to the Local Network ID on
the AS/400, and can be up to eight characters, including
A-Z, 0-9, @, #, and $.

This name is used to identify the AS/400 on the network.

Link type descriptions

The following table lists the link types that the Rumba Router supports.

Link Type Function

APPN Connects to an AS/400 host by using an existing network
connection as a node. For example, an APPN connection
between your PC and an AS/400 host can be used to
access another AS/400 host that does not have a direct
physical connection to your PC.
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Link Type Function

MPTN (SNA over TCP/IP) Connects to an AS/400 host using SNA® or APPC to
communicate over TCP/IP networks. The full capability of
the Rumba APPC engine is used over an existing TCP/IP
backbone, linking client workstations to the host and
providing transparent access to functions such as AS/400
printing and file transfer.

Native TCP support
Rumba AS/400 software supports access via native TCP for a number of client applications. With the
implementation of this feature, Rumba software provides support for the complete range of client
applications. Companies moving to TCP/IP networking can still give their users access to key AS/400
applications which are important for user productivity.

Rumba TCP architecture
The following figure depicts the data flow from your workstation to your AS/400.

Rumba AS/400 software’s Winsock support makes it possible for you to use your existing TCP/IP
connection as the link between AS/400 File Transfer or Submit Remote Command and your host.

Rumba AS/400 Display and AS/400 Printer provide display and printer support directly over TCP/IP as
well.

Supported Rumba components
The following table details the functions performed by Rumba software components that use native TCP.
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Component Function

Display

Rumba AS/400 Edition Display & TN5250 interface Presents the traditional AS/400 display terminal in a
Microsoft Windows application: the Rumba window.

Users can run multiple host sessions, displaying and
working with host applications simultaneously.

Printing

Rumba AS/400 Printer Includes standard features such as: AS/400 printer
queues, PC printer queues, and print log.

Note: Printing with TCP/IP is now available using
TN5250.

File Transfer

AS/400 File Transfer Transfers files or selected data between the AS/400 host
and your PC.

Configuring a TCP connection
The procedure for configuring your host connection depends on which desktop application you use. Refer
to the following list for the procedures you need to configure your connection.

If you plan to use Data Access, use the 32 bit ODBC program, which resides in the Control Panel, to define
and manage a data source for the Rumba AS/400 Optimized Server ODBC driver. Click the Configure
Rumba APPC button if you need to configure a Rumba APPC connection.

If you plan to use TN5250, use the Connection Configure dialog box to configure a Rumba Router TN5250
host link

Trace support for TCP applications
To obtain trace data from your host connection use the Rumba Trace Utility.

For more information, see Rumba Tools Guide.

Configuring an MPTN connection
The options you can specify with the third Link Configuration dialog box tab vary a great deal depending on
which link type you use. This section discusses the options you specify to configure a host connection
using the Rumba Router and an MPTN link type.

About MTPN
In this section, the MPTN interface is described as a LAN direct connection type.

Multi Protocol Transport Networking (MPTN) is an open architecture that allows integration of multiple-
vendor and multiple-protocol environments.

The primary advantage MPTN has for users of existing Rumba software products is that this new interface
allows you to use either SNA or APPC to communicate over TCP/IP networks. This means that you can
use the full capability of the Rumba APPC engine over your existing TCP/IP backbone. Effectively, this
links your client workstation directly to the AS/400, providing transparent access to functionality, such as
AS/400 printer and file transfer.

Rumba MPTN supports various APIs:
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• EHNAPPC
• CPIC
• APPC

Various applications work with Rumba MPTN:

• Database Applications
• Printer Configurations
• AS/400 Display
• AS/400 File Transfer

AS/400 considerations
Before you can connect to an AS/400 using the MPTN interface, the AS/400 must be set up to use the
TCP/IP protocol. In order for your AS/400 to communicate using TCP/IP, it must be running OS/400,
Version 3.0, Release 1 (or later).

Note: This is an absolute requirement.

Earlier versions of the operating system do not allow you to properly configure TCP/IP addresses for either
your AS/400 or your client workstations.

MPTN parameter descriptions
The figure below illustrates the MPTN Configuration tab of the Link Configuration dialog box.

The following table lists and describes the parameters on the MPTN Configuration tab.
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Parameter Name Description

Remote Host Name Type in the remote host name or IP address you wish to
access.

Use Host APPN Remote Location List Specifies that the system name sent with your connection
request will be the Link Name/Remote LU Name you
entered for this workstation. When this option is not
selected, the system name sent with your connection
request will be MPTN.

When you configure a connection to an AS/400 host that
uses APPN Remote Location List security, you can use
this security option.

KeepAlive Specifies whether host KeepAlive settings are negotiated
as part of the connection process.

Configuring a Microsoft SNA Server connection
This section discusses the options you specify to configure a host connection using the Microsoft SNA
Server protocol.

About Microsoft SNA Server
In this guide, the Microsoft SNA Server interface is described as a LAN gateway connection type.

Before running Rumba software with the Microsoft SNA Server interface, you must run the Microsoft-
supplied configuration utility and configure the workstation as an APPC client. Also, you must run the
supplied snabase.exe utility to start communication between the workstation and the Microsoft SNA
Server.

Diagnostics
This section introduces two tools you can use in diagnosing connection problems that your users may
encounter when trying to establish a host connection.

Rumba Trace Console
Use the Rumba Trace Console to trace and record SNA and link layer communication sessions. These
trace options can have an impact on your system performance, so it is best to use them as a filter to sift
through your communication sessions when isolating a problem.

Help topic: Rumba Administrative Tools > Rumba Trace > Using the Rumba Trace Console

Rumba Event Viewer
Use the Rumba Event Viewer to view recorded session events. An event is any significant occurrence,
including fatal and non-fatal session errors.

The Rumba Event Viewer works in the background collecting information at timed intervals that you can
set, and keeps an event log organized by Data, Time, Source, Event ID, Type, and Computer.

Note: The Rumba Event Viewer is very similar in appearance and functionality to the Windows Event
Logger.

AS/400 Getting Connected | 63



Configuring the AS/400 Communications Utility
This section describes the AS/400 Communications Utility.

Overview of the Rumba AS/400 Communications Utility
You use the Rumba AS/400 Communications Utility to configure host connections for:

• AS/400 File Transfer
• Shared Folders application and API
• Data Queues API
• Submit Remote Command API
• Virtual Print application and API

Configurations are saved as a file with an .ehn extension. You can create multiple configuration files for
each interface that you use.

Connecting to the host
The connection is configured from the Connection menu.

1. Select the Configure option.

2. Select the interface you will be using.

3. Click the Properties button and configure the interface, if required.

4. Click the Connect button.
After connecting to the host, you can save your settings as a profile.

Interface tab

This section lists and describes the parameters on the Interface tab of the Rumba AS/400 Communications
dialog box.
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Procedure Name Description

Communications Interface list Lists the installed communication interfaces. Select which
type of communication interface to use when connecting
this profile to the host.

Configure Configures the selected interface (displays the Rumba
Router dialog box). If the interface has already been
configured, you do not need to do so again, unless you
want to make changes.

Procedures for using the Rumba Router and configuring other communication interfaces can be found in:

Using the RUMBA Router to Configure an APPC Link

Security tab

Security tab

This section lists and describes the parameters on the Security tab of the Rumba AS/400 Communications
dialog box.

Parameter Name Description

Use Common Sign-on Uses the specified User ID and Password as sign-on
information for all systems.

AS/400 Sign-ons list Lists the current AS/400 systems you have configured
security settings for. You must add systems on the
Interfaces tab before you can configure security settings
for them.

Add Sets up security for a new system (displays the Add
System Sign-on dialog box).

Change Changes the security settings for the selected system.

Delete Deletes the security settings for the selected system.

AS/400 Getting Connected | 65



Parameter Name Description

Enable Caching of User ID’s and Passwords Enables the storing of the User ID and password for the
currently configured system until you reboot your PC. If
you choose Enable Caching of User IDs and passwords,
you will not have to enter your User ID and password for
subsequent connections unless you reboot.

Add System Sign-on dialog box Sets up security for a new system. This dialog box
appears when the Add button is clicked from the Security
tab.

AS/400 System Name Lists the selected system name.

User ID Becomes the User ID that will be required when signing
on to the selected system.

Password Becomes the password that will be required when signing
on to the selected system. This is optional, unless a
password is required by the system you are connecting
with.

Verify Password Verifies the correct spelling of your password. An error
message will be displayed if this password does not
match the first password you entered.

OK Saves any changes you have made and closes the dialog
box.

Cancel Ignores any changes you have made and closes the
dialog box.

Reset Removes changes and restores the original settings.

Character tab
This section lists and describes the parameters on the Character tab of the Rumba AS/400
Communications dialog box.

Parameter Name Description

Host Character

Set/Code Page

Displays all the character sets and corresponding code
pages available for the AS/400 display.

Diagnostics tab
This section lists and describes the parameters on the Diagnostics tab of the Rumba AS/400
Communications dialog box.

Parameter Name Description

Display EHNAPPC

Error Messages

Displays additional diagnostic error message boxes when
a communications error occurs. These do not replace
standard error messages.
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AS/400 File Transfer
This section provides a general overview of the Rumba AS/400 File Transfer program, along with reference
information to help you serve as a resource for your organization's Rumba users.

The Rumba AS/400 File Transfer program sends data between the host and the PC. Users can run the
AS/400 file transfer program to send host files or selected host data to the PC, work with the data in a PC
application, and then run the file transfer program to send the modified PC data back to the AS/400.

In addition to the AS/400 file transfer program, you can also transfer files using Mainframe Passthrough.

AS/400 file transfer features
The Rumba AS/400 File Transfer program provides multiple options for transferring data between the
AS/400 host and the PC. You can:

• Create, open, and save file transfer settings in a profile
• Run individual or multiple (batch) file transfers
• Transfer text or database files from the PC to the AS/400
• Use the drag-and-drop feature to transfer host data to the PC display, the printer, or to a PC file
• Transfer complete host files to the PC or use SQL to transfer only the information you need
• Display libraries you can access on the host, and add libraries for the current file transfer session
• Specify decimal, date, and time formats for the transferred data
• Remove End of File character from host file before sending to PC
• Specify transfer options such as Run minimized, Monitor percent complete, Notify when complete,

Close when complete, Truncate records, Truncate spaces, and Auto Run.
• Forward host files to an email address

Installation
The Rumba AS/400 File Transfer program is included in the default installation for Rumba AS/400 Edition.
When performing a custom installation for the AS/400 edition of Rumba you can select or deselect the
AS/400 File Transfer option.

After installing the AS/400 file transfer program at the workstation, you can create and distribute
customized file transfer profiles that your users can run with the click of a button.

Planning an administrative strategy
You can simplify the file transfer process for your end users by creating and distributing profiles for all data
transfers that need to be run on a regular basis. For example, many users may need to create weekly
reports or spreadsheets based on host data. You can automate the file transfer program by following this
sequence of steps:

1. Analyze the problem.

Which users transfer data to and from the host on a frequent or regular basis? What kinds of transferred
data do they need? How would they best benefit from an automated file transfer procedure?

2. Design individual file transfer profiles.
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Based on your analysis, create customized file transfer profiles to meet the individual needs of your
users. This includes configuring:

• The default communications interface for the AS/400 File Transfer program
• Transfer options such as Run minimized, Notify when complete, and Monitor percent complete
• The location and format of the data files on the PC and the host

Help topic: Transferring files > AS/400 file transfer > The AS/400 File Transfer application > Basic
transfer procedures > To save settings in a transfer profile

3. Use SQL (Structured Query Language) statements if appropriate.

When sending AS/400 data to the PC, you can use SQL statements to transfer only the AS/400 data
that users need, instead of transferring complete files. You can also sort, group, summarize, and
perform mathematical calculations on the transferred data.

Help topic: Transferring files > AS/400 file transfer > The AS/400 File Transfer application >
Querying host data

4. Create batch transfers that run multiple file transfers in a single step.

You can group individual file transfer profiles in a batch profile so users can run the specified transfers
in a single step. Batch transfers can also be scheduled to run once, or on a daily, weekly, or monthly
basis.

Help topic: Transferring files > AS/400 file transfer > The AS/400 File Transfer application > Using
batch file transfers

5. Use the Auto Run option to run file transfers from the Windows Desktop.

When you save individual or batch transfer profiles with the Auto Run option, users can run their file
transfer profile by simply double-clicking a shortcut on the Windows Desktop.

Help topic: Transferring files > AS/400 file transfer > The AS/400 File Transfer application > Basic
transfer procedures > To create an auto run transfer

Help topic: Transferring files > AS/400 file transfer > The AS/400 File Transfer application > Using
batch file transfers > To configure batch options

User files
There are several different types of user files that are associated with Rumba AS/400 File Transfer and
stored on the workstation in the user’s private directory. The following table summarizes these files.

File name Description

.btf Batch transfer profile for multiple file transfers

.fdf File description file (required when sending database files
from the PC to the AS/400)

.rto Transfer profile for a single file transfer

.tfr PC Support/Client Access file transfer profile (upload)

.tto PC Support/Client Access file transfer profile (download)

Rumba AS/400 File Transfer file types

Configuration procedures
The Rumba online help contains detailed information on configuring individual and batch file transfers. This
section describes additional procedures that a system administrator may need to set up the AS/400 file
transfer program for their users.
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Changing the library list on the AS/400 host
When you initially open the AS/400 file transfer program, Rumba software reads the QDFTJOBD (default
job description) file on the AS/400 and displays the list of libraries included in this file. To display other host
libraries which your users have access to, you must change the QDFTJOBD file. You can change the
QDFTJOBD file for the entire system or for a single user. The following procedures tell you how to change
the QDFTJOBD file.

To change the QDFTJOBD file of a single user, follow all the steps below. In summary, you must:

1. Copy the QDFTJOBD file into a new host library.
2. Change the library list as needed in the copied QDFTJOBD file.
3. Update the user profile to reflect the new QDFTJOBD file. (Generally, the host uses the QDFTJOBD file in

the QGPL library by default.)

To change the QDFTJOBD file for the entire system, follow only the instructions under “To change the
library list in the QDFTJOBD file.”

If you need to change the QDFTJOBD file during a file transfer session, click or choose Request Libraries
from the File Transfer Session menu to update the current library list.

To copy the QDFTJOBD file
Enter the context of your task here (optional).

1. At the AS/400 command line, type WRKJOBD, then press F4.

This displays the Work with Job Descriptions screen.

2. At Job Description, type QDFTJOBD; at Library, type QGPL, and then press Enter.

3. Under Opt, type 3 to copy the file, and then press Enter.

This displays the Create Duplicate Object screen.

4. At To Library, type the new library name for the copied file, and press Enter.

To change the library list in the QDFTJOBD file
To change the library list in the QDFTJOBD file:

1. At the AS/400 command line, type WRKJOBD, then press F4.
This displays the Work with Job Descriptions screen.

2. At Job Description, type QDFTJOBD; at Library, type the name of the new library containing the
copied QDFTJOBD file, and then press Enter.

3. Under Opt, type 2 to make changes to the file, and then press Enter.

This displays the Change Job Description screen.

4. Press F10 and Page Down.

5. Under Initial Library List, at + for more values, enter the plus sign [+] and type the names of the host
libraries you want to list.

6. Press Enter twice.

To update the user profile

1. At the AS/400 command line, type CHGUSRPRF then press Enter.

2. At User Profile, type the name of the profile to change.

3. Press F10, then press Page Down twice.
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4. Under Job Description, at Library, type the name of the library containing the new QDFTJOBD file, and
then press Enter.

Creating a PC description file
When sending a PC database file to the AS/400, file and field descriptions for both the AS/400 system and
the PC file are required. The host uses this information to correctly identify and interpret the field data. The
PC description file (.fdf) contains information describing the PC database file. It is a text file that identifies
the file data type (such as text or DIF), and contains field data information including the name, data type,
and length of each field in the transferred file.

When transferring data from the AS/400, you can create a PC description file automatically by checking the
Save description file box below.

Help topic: Transferring files > AS/400 file transfer > the AS/400 file transfer application > Receiving
AS/400 data

Conversely, the PC description file is required when sending a PC database file to the host. If necessary,
you can use any text editor to create a PC description file following these conventions:

• Use ASCII format.
• Use a carriage return and line feed to end each record.
• Tab characters can be used, but they will be treated as spaces.
• Place an end of file (EOF) character at the end of the file.
• Recommended naming convention: Use the same name as the PC database file you are transferring,

but with an .fdf extension.

More information: Transferring files > AS/400 file transfer > the AS/400 file transfer application >
Sending PC files to the AS/400 > To create a PC description file?
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Structure of the PC description file
The PC description file contains four types of information that describe the PC database file:

• PCFDF
• PCFT file type
• PCFO (optional time, date, and decimal formats)
• PCFL entries (field name, data type, length) for each database field

These information types are described below.

PCFDF
Identifies this file as a description file.

PCFT file type
Identifies the file type of the PC database file.

Indicator File type

1 ASCII text

3 BASIC sequential (CSV)

5 DIF (Data Interchange Format)

6 No-conversion file

7 Reserved (DBCS version only)

8 DOS random type 2

9 BIFF (Binary Interchange Format)

10 Tab-delimited text

PCFO
Optional PC time, date, and decimal format entries.

Indicator Time format name Time format

1 HMS hh:mm:ss

2 ISO (International
Standards Organization)

hh.mm.ss

3 USA (USA standard) hh:mm AM or PM

4 EUR (European) hh.mm.ss

5 JIS (Japan Industrial
Standard, Christian Era)

hh.mm.ss

6 DDS format given by AS/400
file attributes

7 DFT host job default

* Unspecified host job default

Indicator Time Separator

1 Colon (:)

2 Period (.)

3 Comma (,)

4 Blank ( )
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Indicator Time Separator

5 Null (N)

6 Default (D) (host)

* Unspecified (host job default)

Indicator Date format name Date format

1 MDY mm/dd/yy

2 DMY dd/mm/yy

3 YMD yy/mm/dd

4 Julian yy/ddd

5 ISO yyyy-mm-dd

6 USA mm/dd/yyyy

7 EUR dd.mm.yyyy

8 JIS yyyy-mm-dd

9 DDS format given by AS/400
file attribute

10 DFT host job default

* Unspecified host job default

Indicator Date Separator

1 Slash (/)

2 Dash (--)

3 Period (.)

4 Comma (,)

5 Blank ( )

6 Null (N)

7 Default (D) (host)

* Unspecified (host job default)

Indicator Decimal Separator

1 Period (.)

2 Comma (,)

3 Default (D) (PC country default)

* Unspecified (PC default used)

PCFL entries
Describes the database fields; include one PCFL entry for each field in the database. Each
entry consists of:

• PCFL (Personal Computer Field Length)
• The field name (maximum 10 characters)
• A number designating the data type
• The field length in characters
• PCFL entries
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Indicator Data type

1 ASCII

2 ASCII numeric

3 Hexadecimal

4 Binary

5 Zoned

6 Packed

7 BASIC integer

8 BASIC single-precision floating point

9 BASIC double-precision floating point

10 EBCDIC

11 EBCDIC zoned

12 EBCDIC packed

Sample PC description file
Here is a sample PC description file with commentary:

File entry Comment

PCFDF PC description file

PCFT 9 PC file in BIFF format

PCFO 7,6,10,7,*

Option Settings

Host default date and time formats

PCFL BINARY 9 7/2 The first field, BINARY, is double-precision floating point
and 7 characters in length, precise to 2 decimal places.

PCFL CHAR 1 10 The second field, CHAR, is an ASCII field and has a
length of 10 characters.

PCFL ZONED 9 8/4 (The other fields in the database are interpreted as
above.)

PCFL PACKED 9 11/2

PCFL HEX 3 10

PCFL DATE 1 8

PCFL TIME 1 8

Working with SQL
When transferring data from the AS/400 host to the PC, you can use the system default to transfer
complete files, or you can use SQL (Structured Query Language) to send specific AS/400 data. SQL is a
standardized query language for requesting information from a host database. You can use SQL to transfer
data from specified fields and records in one or more host files, sort the transferred data, and perform
simple calculations on the transferred data. This section contains three short SQL tutorials to help you get
started. For more information on using SQL, consult your AS/400 host documentation, along with any SQL
reference manual.
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Introduction to the query tutorials
The SQL tutorials demonstrate various query keywords using sample data from an imaginary grocery
store. There are three sample queries:

• Lesson 1 is a simple query using SELECT, WHERE, and ORDER BY
• Lesson 2 selects data from three files using JOIN BY
• Lesson 3 transfers summary records using GROUP BY and HAVING

To build a query, you must first specify the AS/400 data file(s) in the Lib/File(Member) box on the main
AS/400 File Transfer screen. These lessons use three sample AS/400 files named PRODUCT, SUPPLIER,
and SUPPROD in a library named GROCERY. The first few records of each file are listed in the following
tables.

ProdCat ProdID ProdDesc ProdName ProdQuant

100570265 129930113 Wild Berry Summerbrook Wild Berry Seltzer 84

100570265 129930513 Apple-Cran Summerbrook Apple-Cran Seltzer -9

100570265 129935223 Black Currant Olympia Black Currant Seltzer 125

100570267 129935423 Sparkling Lemonade Olympia Sparkling Lemonade 7

100570262 761837634 Cherry Lime Olympia Cherry Lime Soda 54

100570263 761831637 Cranberry Ice Tea Crystal Falls Cranberry Ice Tea 302

100570263 761831635 Diet Peach Ice Tea Crystal Falls Diet Peach Tea 79

100570263 761831636 Diet Rasp Ice Tea Crystal Falls Diet Rasp Ice Tea 110

100570263 761831638 Lemon Ice Tea Crystal Falls Lemon Ice Tea 218

100570100 165712111 Mineral Water Whisper Rain Mineral Water 22

100570262 165712115 Mango Passion soda Dave’s Mango Passion soda -22

ProdID SupID ProdCost

129831040 50500 6.30

129930113 50500 12.50

129935423 40230 13.50

129935223 40230 10.80

129930513 50500 13.50

129930613 50500 11.50

754030150 30250 5.20

754030220 30250 6.50

754030330 30250 5.80

165712115 10455 3.00

165712111 10455 3.00

165712113 10455 7.20

165712115 50750 2.90

76183163 50750 6.00

761831635 50500 5.00

761831636 50500 5.00
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ProdID SupID ProdCost

761831637 50500 5.00

761831638 50500 5.00

165712115 40230 2.85

761837634 5500 10.20

129935223 5500 11.00

129935423 5500 10.50

SupID SupName SupCity SupZip SupState

50500 Moore’s Fine Foods Kirkland 98801 WA

10455 Kolb Bros. Tumwater 98502 WA

30250 Laura's French Bakery Seattle 98124 WA

40230 Silves Wholesale Blaine 98009 WA

50750 D&C Distributors Cashmere 98801 WA

The following lessons describe the process of using the Overview tab of the From AS/400 - Options dialog
box to build SQL statements. However, you can also build each SQL statement by specifying the
necessary data on the appropriate keyword tabs.

Help topic: Transferring files > AS/400 file transfer > the AS/400 file transfer application > Querying
host data

Lesson 1: Using SELECT, WHERE, and ORDER BY
To transfer a list of all available types of tea drinks sorted alphabetically:

1. Specify the GROCERY/PRODUCT file in the Lib/File(Member) box on the main file transfer screen, then
open the From AS/400 - Options dialog box.

2. Verify that the Select field on the Overview tab has an * in it. This indicates that all fields in the
PRODUCT file will be transferred.

3. To transfer all records containing the string “Tea,” type this string in the Where field:
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PRODNAME LIKE ‘%Tea%’

The % character is a wildcard indicating any number of characters.

4. To sort the data in ascending order by the type of drink, type this string in the Order By field:

PRODDESC

5. Click Apply to update the query fields.

SELECT *
FROM grocery/product
WHERE (PRODNAME LIKE ‘%Tea%’)
ORDER BY PRODDESC

The resulting records are:

ProdID ProdDesc ProdName ProdQuant

100570263 761831637 Cranberry Ice Tea Crystal Falls Cranberry Ice Tea 302

100570263 761831635 Diet Peach Ice Tea Crystal Falls Diet Peach Tea 79

100570263 761831636 Diet Rasp Ice Tea Crystal Falls Diet Rasp Ice Tea 110

100570263 761831638 Lemon Ice Tea Crystal Falls Lemon Ice Tea 218

Lesson 2: Querying multiple files with JOIN BY
This query finds the suppliers and prices for a given product. Multiple files are joined so they can be
queried as if they were one file. This is necessary because the GROCERY library stores data in separate
files linked by common fields rather than using one large file: The PRODUCT and SUPPROD files share
the ProdID field, and SUPPROD and SUPPLIER files share the SupID field.
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With JOIN BY, the relationships between files become part of the query. Without joining the files, you
would need three queries to get the same result: one for product ID, one for product cost, and one for
supplier name.

To find the suppliers and prices for Dave’s Mango Passion soda:

1. Specify the GROCERY/PRODUCT, GROCERY/SUPPROD, and GROCERY/SUPPLIER files in the Lib/
File(Member) box on the main file transfer screen, then open the From AS/400 - Options dialog box.

2. To transfer only the product name, product cost, and supplier name fields, type this string in the Select
field on the Overview tab:

T1.ProdName, T2.ProdCost, T3.SupName

3. To join records in the three files by the product ID and supplier ID, type this string in the Join By field:

T1.PRODID = T2.PRODID AND T2.SUPID = T3.SUPID

4. To search all records with the string “Mango Passion”, type this string in the Where field:

T1.PRODNAME = 'Dave’s Mango Passion soda'

5. Click Apply to update the query fields.

The Query box at the top of the Overview tab displays the complete query statement:

SELECT T1.ProdName, T2.Prodcost, T3.SupName
FROM grocery/product, grocery/supprod, grocery/supplier
WHERE (T1.PRODID=T2.PRODID AND T2.SUPID=T3.SUPID) 
AND (T1.PRODNAME=’Dave’s Mango Passion soda’)

The resulting records are:

ProdCost SupName

Dave’s Mango Passion soda 3.00 Kolb Bros.

Dave’s Mango Passion soda 2.90 D & C Distributors

Dave’s Mango Passion soda 2.85 Silves Wholesale

Lesson 3: Summarizing records with GROUP BY
What is the least expensive mineral water product? To answer this question, you must obtain the product
costs from multiple suppliers for all mineral water products in each vendor's product line, then average the
costs, group the data by vendor, and sort the data by cost.

With SQL, you can use summary records to obtain the answer by running a single query. The PRODUCT
file includes a ProdCat (product category) field in which all mineral water products are identified by the
value 100570100. The ProdName field contains the vendor name.

To transfer a summary record for each product name:

1. Specify the GROCERY/PRODUCT, GROCERY/SUPPROD, and GROCERY/SUPPLIER files in the Lib/
File(Member) box on the main file transfer screen, then open the From AS/400 - Options dialog box.

2. To transfer a summary record of the average cost and the product name field, type this string in the
Select field on the Overview tab:

AVG(T2.PRODCOST), T1.PRODNAME

3. To join records by product ID and supplier ID, type this string in the Join By field:

T1.PRODID = T2.PRODID AND T2.SUPID = T3.SUPID

4. To search records that are mineral water products, type this string in the where field:

T1.PRODCAT =100570100

5. To perform summary calculations on records of the same ProdName, type this string in the Group By
box:

T1.PRODNAME
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6. To sort the results from lowest to highest product cost, type this string in the Order By box:

AVG(T2.PRODCOST)

7. Click Apply to update the query fields.

The Query box at the top of the Overview tab displays the complete query statement:

SELECT AVG(T2.PRODCOST), T1.PRODNAME
FROM grocery/product, grocery/supprod, grocery/supplier
WHERE (T1.PRODID=T2.PRODID AND T2.SUPID=T3.SUPID) 
AND (T1.PRODCAT=’100570100’)
GROUP BY T1.PRODNAME
ORDER BY AVG(T2.PRODCOST)

The resulting records are:

ProdCost

Whisper Rain Mineral Water 3.00

Maple Falls Mineral Water 3.17

Mt. Baker Sparkling Water 3.35

Panda Mineral Water 3.62

Panda Sparkling Lemon Essence 3.81

Panda Sparkling Lime Essence 3.81
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AS/400 Client Application
This section introduces the AS/400 Client Application.

Overview
An additional feature available in Rumba Office and Rumba AS/400 Edition is the AS/400 Client
Application: Rumba Submit Remote Command (application and API)

The AS/400 Client Application brings many powerful features and possibilities to your desktop. Rumba
Submit Remote Command allows you to start and control non-interactive programs on your AS/400 host
system without opening a display session.

The associated AS/400 Client APIs are development tools; with these APIs and a high-level programming
language such as C, C++, or Visual Basic, you can develop custom PC applications which incorporate the
functionality of the Rumba AS/400 Client Application. Before you can use the AS/400 Client APIs, you must
install the Legacy API help and header files.

Help file: Rumba utilities > Submit Remote Command

AS/400 Client installation and availability
The AS/400 Client Application is included under an Express installation of Rumba AS/400 Edition.
However, you can select or deselect the application by performing a Custom installation. The AS/400
Client Application is listed under the AS/400 branch in the Select Features dialog box of the installation
program.

Before starting
Before using the AS/400 Client application, you must configure an interface to connect with an AS/400 via
the Rumba AS/400 Communications utility or the APPC Configuration Utility. These utilities reside in the
Rumba Tools folder. For instructions on using the Rumba AS/400 Communications utility or APPC
Configuration Utility, see Other Connection Tools Guide.

Note: If you have already configured an interface with the Rumba AS/400 Display or Printer, you do
not need to reconfigure the interface through either of these utilities.

Interfaces supported
The Rumba AS/400 Client Application requires an interface that supports full LU 6.2 capabilities. These
interfaces include:

• Rumba Router (only MPTN supported).
• Microsoft SNA Server - All connection subtypes for the Microsoft SNA Server Client are supported.

Note: The Microsoft SNA Server Client software must already be installed and configured, and
that the Microsoft SNA Server itself must be correctly configured and functional.

• TCP/IP - If your AS/400 operating system supports Optimized Server (V3 R1 or higher), you can
connect Rumba AS/400 Client Applications over the TCP/IP interface.
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Rumba Submit Remote Command
Use the Rumba Submit Remote Command utility to start and control non-interactive programs on an
AS/400 host from your PC without opening an AS/400 display session. Commands may be sent
individually or in combination and can be saved as an ASCII file for re-submission. Return codes are
received but program data cannot be returned from the host system.

For an example of using Submit Remote Command, imagine your accounts receivable department prints a
group of reports every morning which requires them to enter a series of AS/400 commands. You can
streamline the process in the following manner:

1. Create an ASCII file of the AS/400 commands in Rumba Submit Remote Command,
2. Open the file and press the Send All button.

The Submit Remote Command utility also has a command line interface which allows you, for example, to
execute Submit Remote Command from a PC batch file and send AS/400 commands in a specified .txt file.

The Rumba Submit Remote Command utility is located in the Rumba Administrative Tools folder. Submit
Remote Command is also a legacy API and available as an ActiveX control in the Rumba ObjectX
Development Kit.

Help topic: Rumba Utilities > Submit Remote Command
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Mainframe File Transfer
This section provides a general overview of the Rumba Mainframe File Transfer feature, and contains
concise host-specific information. For in-depth information, please refer to the appropriate location in the
Rumba online help.

File Transfers on the Mainframe
The file transfer feature copies files between your PC and the Mainframe. The Send and Receive
commands, on the Transfer menu in the Mainframe Display, open a setup window where you specify the
file type, transfer protocol, and host environment for the file transfer. You can also choose to have Rumba
software initiate the file transfer protocol. Rumba software for the Mainframe works transparently with most
IBM host operating systems, including CICS, TSO, and VM/CMS.

Rumba software for the Mainframe provides abundant functionality, like support for ASCII or binary
transfers, Write Structured Field or Buffered data streams, EBCDIC-to-ASCII translation, and data
compression. Rumba software for the Mainframe also supports DOS-based, batch, and drag-and-drop file
transfer features.

Transfer capabilities
Rumba software works transparently with standard Mainframe operating systems. This allows an
application on one platform to access and use data on another platform.

Transfer setup
Rumba software for the Mainframe simplifies the file transfer setup process by using typical Windows
menus and dialog boxes. It reads and lists PC and host files, and lets you transfer files in the background.
You can also perform file transfers using the configurable tool bar.

Transfer startup
To start a transfer, Rumba software file transfer submits a command to a host file transfer program. The
most common host program used is called IND$FILE. Rumba software provides abundant functionality,
like support for ASCII or binary transfers, Write Structured Field or Buffered data streams, EBCDIC-to-
ASCII translation, and data compression. Rumba software for the Mainframe also supports DOS-based,
batch, and drag-and-drop file transfer features.

Sending and receiving files
Sending files from your PC to a Mainframe host, and receiving files from a host to your PC is easily
accomplished once you have configured your PC. Unless you want to change how you transfer files, you
do not have to reconfigure each time you want to send or receive files.

To configure your PC
1. Connect to the host.
2. On the Home tab, in the File Transfer group, click Configure. (In the Classic interface, click Transfer >

Configure
3. In the File Transfer Configuration dialog box, select TSO, CMS, or CICS as the destination host

environment.

Mainframe File Transfer | 81



Note: Click the Templates button to take you to the File Transfer Template Configuration dialog
box. For more information on how to set up a template, see File Transfer Templates.

After configuring your PC and setting up a template to match your host environment, you are ready to
transfer files.

To send a file to the host

1. Connect to the host.

2. Click Send. (In the Classic interface, click Transfer > Send .

3. Under Host File, specify the required host file information. These fields vary, depending on the
destination host environment.

4. Under PC File, specify the PC file to send to the host.

5. Under Data Type, click the appropriate data type options.
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6. Click Transfer to send the file, or click Accept to save the settings for future use.

Enter the tasks the user should do after finishing this task (optional).

To receive a file from the host:

1. Connect to the host.

2. On the Home tab, click Receive (in the Classic interface, click File > Receive .

3. Under Host File, select the host file you to transfer to your PC.

4. Under PC File, select an existing destination file name or enter a new destination file name, and then
select a PC directory.

5. Under Data Type, click the appropriate data type options.

6. Click Transfer to send the file, or click Accept to save the settings for future transfers.

File Transfer Templates
To maximize user productivity, you can use file transfer templates to set up and save frequently used file
transfer settings rather than repeatedly configuring the same types of file transfer.

You may need to transfer files on a regular basis, and Rumba software for the Mainframe provides an
efficient way of making the process easier. Use file transfer templates to set up and save detailed send or
receive instructions for specific files. Saving these instructions as templates makes them available for
repeated use. Rumba software supports DOS-type wildcard characters in your file names and types,
increasing your ability to match larger sets of data on the host or PC with one template.

Tip: When you set up a Send template, it is a good idea to set up a corresponding Receive template
that reverses the steps you have specified for the Send.

There are several different types of templates that you can create depending on your host environment.

Creating a TSO template
To create a TSO file transfer template:

1. Configure a file transfer.

2. Under Host Environment, choose TSO.

3. Verify that the Enable Templates box is checked, then click the Templates button.

The TSO File Transfer Template Configuration dialog box opens.

4. Click Send or Receive, depending on the type of template you are creating.

5. Under Name Conversion, you can either modify a default template or create a new one. If you type a
new PC File Name, Rumba software saves a new template under that name. If you do not change the
PC File Name but modify its template settings, Rumba software saves your setting changes in the
default template.

6. When you are done, click OK.

This template is now available to you when you perform a TSO file transfer operation.

Creating a CMS template
To create a CMS file transfer template:

1. Configure a file transfer.

2. Under Host Environment, choose CMS.

3. Make sure the Enable Templates box is checked.
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4. Click the Templates button.

The CMS File Transfer Template Configuration dialog box opens.

5. Click Send or Receive, depending on the type of template you are creating.

6. Under Name Conversion, you can either modify a default template or create a new one. If you type a
new name in the PC File name box, Rumba software will save a new template under that name. If you
do not change the PC File name but modify its template settings, Rumba software will save whatever
setting changes you make in the default template.

7. When you are done, click OK.

This template is now available to you when you perform a CMS file transfer operation.

Creating a CICS template
To create a CICS file transfer template:

1. Configure a file transfer.

2. Under Host Environment, choose CICS.

3. Make sure the Enable Templates box is checked.

4. Click the Templates button. The CICS File Transfer Template configuration dialog box opens.
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5. Click Send or Receive, depending on the type of template you are creating.

6. Under Name Conversion, you can either modify a default template or create a new one.

If you type a new name in the PC File Name box, Rumba software will save a new template under that
name. If you do not change the PC File Name but modify its template settings, Rumba software will
save whatever setting changes you make in the default template.

7. When you are done, click OK.

This template is now available to you when you perform a CICS file transfer operation.

Batch File Transfers
You can use batch files to transfer several files between your PC and the mainframe host. A batch file
consists of two main components: a batch list, and send or receive commands. The batch list serves as a
means of grouping send and receive commands that you can run from your batch file. You can have
several batch lists within one batch file, and several commands within each batch list.

If you only need one batch file, you can use the default batch file DEFAULT.FTB. You can also use drag
and drop for multiple file transfers.

You can use drag and drop for multiple file transfers.

To create a batch file
If no batch files are defined, a New Batch List dialog box opens. Otherwise, click the New button in the
Batch File area at the top of the dialog box.

1. On the Home menu, in the File Transfer group, click Batch. (In the Classic interface, click Transfer >
Batch .

2. Specify a name for the new batch file, then click OK.

The new batch file name appears in the Name box of the File Transfer Batch dialog box.

3. Under Commands In List, click the New button.

The File Transfer Template Configuration dialog box opens, where you can set the Template
commands for the new batch file.
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4. Click the Send button to send files to the host, or the Receive button to receive files from the host.

5. Select the file(s) to transfer, then click OK. You can use file extensions and wild cards to transfer
multiple files with a single command.

6. Repeat steps 3 - 5 to add transfer commands as needed.

7. Click Accept to save your settings, or Transfer to save settings and run the batch file transfer.

To run a batch file transfer
To start a batch file transfer:

1. Open your Rumba profile and connect to the host.

2. On the Home menu, in the File Transfer group, click Batch. (In the Classic interface, click Transfer >
Batch .

3. Select the batch file you want to use. Batch files have an .ftb extension.

4. Click Open.
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5. To run individual lines in a batch file, select the lines you want to start before clicking the Transfer
button on the File Transfer Batch dialog box.

6. Click the Transfer button to start the batch file transfer.

Rumba File Transfer Registry Settings
This section discusses Windows Registry settings that you need to know about when you are installing an
upgrade version of Rumba software for the Mainframe over an existing 16-bit version.

File Transfer Registry settings
The installation program converts settings that were previously in the rumba.ini file into Windows Registry
settings. The following table lists the old file transfer rumba.ini settings, the new Windows Registry settings,
and the purpose of each setting.

Table 21: File transfer Windows Registry settings

This rumba.ini Setting Converts to this Windows Registry
Setting

Purpose of the Setting

[FTX] Blank Screen BlankScreen (DWORD) BlankScreen is used to set whether
the screen should be blank while
Rumba software displays the File
Transfer Configuration dialog box.
When the dialog box is first opened,
the screen is frozen. When the dialog
box is dismissed, the screen is
refreshed with the current buffer
contents.

[FTX] NOPA1 NOPA1 (DWORD) The NOPA1 setting is used to disable
the PA1 key from being automatically
sent to the host following a TSO file
transfer or file list command. Some
host applications, such as session
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This rumba.ini Setting Converts to this Windows Registry
Setting

Purpose of the Setting

managers, reserve the PA1 key for
special functions. Enabling the
NOPA1 setting prevents Rumba
software from interfering with these
host applications. You disable the
setting by assigning it the value 0,
and enable the setting by assigning
the value 1.

Note: For compatibility with
older versions of Rumba
software, the value NOPA1=2
is supported as an alternative
for the ListcatWithATTN
setting.

[FTX] ListcatWith ATTN ListcatWith ATTN (DWORD) The ListcatWithATTN setting
overrides the default behavior of
sending a PA1 following a LISTCAT
command. Rumba software issues
the LISTCAT command internally to
generate the file list in the file transfer
dialog box. When ListcatWithATTN is
specified, the LISTCAT command is
terminated by sending an Attention
key, rather than a PA1, to the host.
To disable the setting, assign it the
value 0; to enable the setting, assign
it the value 1.

[FTX]IND_Timeout IND_Timeout (DWORD) The IND_Timeout setting is used to
adjust file transfer responsiveness by
specifying the amount of time to wait
before timing out during a file transfer
command. The setting specifies the
timeout in milliseconds.

[FTX] List_Timeout List_Timeout (DWORD) The List_Timeout setting is used to
adjust file transfer responsiveness by
specifying the amount of time to wait
before timing-out during a file list
command. The setting specifies the
timeout in milliseconds.

Using Rumba Macros to Transfer Files
You can use the Rumba Macro Editor to create macros that automate and simplify file transfer procedures
for your users. A macro is a type of program that issues commands and reads responses. Macros can
save you a great deal of time by automating file transfer tasks you perform frequently.

To create a file transfer macro
To create a file transfer macro

1. On the Tools tab, click Edit to open the Macro Editor. (In the Classic interface, click Tools > Edit
Macro .

2. On the lower toolbar, click the File Transfer Send button or the File Transfer Receive button
depending on whether you want to send or receive a file.
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3. Configure the file transfer as needed, then click OK.

4. From the Macro Editor File menu, choose Save.

5. Give the macro a name, then click OK.

Help topic: Simplifying your work > Automating tasks > Macros > Creating and editing macros >
Macro commands .

IND$FILE TRANSXX Codes
The most common host file transfer program is IBM’s IND$FILE. This program uses a set of what are
referred to as TRANSXX codes, which convey information about certain key file transfer transactions. The
following table lists the various codes used by the IND$FILE program and gives an explanation of these
codes.

Table 22: IND$FILE TRANSXX codes

TRANSXX code Explanation

TRANS00 Error in file transfer: file transfer canceled This code indicates that an error occurred in the File
Transfer operation that was detected by the CICS File
Transfer transaction. This may be an error in the data
being transferred, or an unidentified system error.
Examine the file for incorrect format or bad data, and
check the installation procedure and the setup of all the
components involved. Re-attempt the File Transfer
transaction.

TRANS01 File Transfer command being processed This code alerts you that the File Transfer transaction is
currently being processed.

TRANS02 Number of bytes of file transferred so far ===>
xxxx

The File Transfer transaction is currently being
processed, and this code informs you of the number of
bytes of information transferred so far.

TRANS03 File transfer complete The File Transfer transaction has completed normally and
the file has been transferred without any errors detected.
Examine the data in the file to determine if the operation
was correctly implemented.

TRANS04 File transfer complete, with records segmented The File Transfer transaction completed successfully, but
at least one of the records of data sent to the host was
longer than the maximum allowed (32767). The record
has been broken into more than one segment, each of
which appears as a separate item in the Temporary
Storage queue. The error may have occurred because
the CRLF option was used when the file did not contain
logical records. Check the contents of the file being
uploaded, and the options used, and re-attempt the file
transfer transaction. Alternatively, use the BINARY option
to transfer the data “as is” from the 3270 to the host
without interpretation. Interpret the data in the host.

TRANS05 Personal computer filespec incorrect: TRANS05 Personal computer filespec incorrect: file
transfer canceled The PC file specified is incorrect. Verify
the file and re-attempt the File Transfer transaction.

TRANS06 Command incomplete: file transfer canceled The File Transfer command entered
is incomplete. Verify the command and re-attempt the
File Transfer transaction.
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TRANSXX code Explanation

TRANS07 Cannot link to host: file transfer canceled A link cannot be established with
the host. Check the status of the host, or refer to the
user’s guide for more information.

TRANS09 Error reading file from damaged personal
computer disk: file transfer canceled

The PC file specified resides on a damaged disk. Copy
the file to an undamaged medium and re-attempt the File
Transfer transaction.

TRANS10 Host has not responded within timeout period: Refer to the user’s guide for more information The host
did not respond within the allotted amount of time. Check
the status of the host, or refer to the user’s guide for more
information.

TRANS11 Lost contact with host: file transfer canceled Re-establish a host connection and re-attempt the File
Transfer transaction.

TRANS12 Error writing to damaged or full personal
computer disk: file transfer canceled

The PC disk specified is damaged or full. Examine the
disk for damage and ensure that it contains enough
space to receive the transferred data. Re-attempt the File
Transfer transaction.

TRANS13 Error writing file to host: file transfer canceled An error occurred while writing the file to the host. Refer
to the user’s guide for more information.

TRANS14 Error reading file from host: file transfer
canceled

An error occurred while reading the file from the host.
Refer to the user’s guide for more information.

TRANS15 Host storage unavailable: file transfer canceled The CICS File Transfer transaction could not obtain
enough storage in which to place its own control blocks,
I/O buffers, or save areas. Make more storage available
to the transaction and attempt to perform the operation
again.

TRANS16 Incorrect request code: file transfer canceled The command that started the file transfer operation did
not specify GET or PUT. The command is rejected.
Check the parameters used to invoke the file transfer
operation and correct them. Re-attempt the File Transfer
transaction.

TRANS17 Invalid file name: file transfer canceled The file name specified is invalid. Verify the file name and
re-attempt the File Transfer transaction.

TRANS18 Incorrect option specified: file transfer
canceled

An incorrect File Transfer option was specified. Verify all
options selected and re-attempt the File Transfer
transaction.

TRANS19 Error handling host file: file transfer canceled An error occurred while handling the host file. Refer to the
user’s guide for more information.

TRANS21 Not enough personal computer memory
available: file transfer canceled

Not enough memory is available on your PC to proceed
with the File Transfer transaction. Close one or more
applications and re-attempt the File Transfer transaction.

TRANS22 Host session identifier incorrect: file transfer
canceled

The host session identifier specified is incorrect. Verify
the identifier and re-attempt the File Transfer transaction.

TRANS23 Activity specified not a host session: file
transfer canceled

The activity specified is not a host session. Verify the
activity and re-attempt the File Transfer transaction.
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TRANSXX code Explanation

TRANS24 Autokey operation in progress: file transfer canceled Wait
for the autokey operation to complete, then re-attempt the
File Transfer transaction.

TRANS25 Keyboard inhibited: file transfer canceled The keyboard has been inhibited. Refer to the user’s
guide for more information.

TRANS26 Unrecoverable system error: file transfer
canceled

An unrecoverable system error occurred. Check the
installation procedure and the setup of all the
components involved. Re-attempt the File Transfer
transaction.

TRANS27 Communication sequence with host disrupted:
file transfer canceled

Communication between your PC and the host was
disrupted. Re-establish a host connection and re-attempt
the File Transfer transaction.
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HP and UNIX File Transfer
Rumba software, the PC-to-host connectivity system, gives you easy, complete, and transparent access to
host applications. PC users working in the Microsoft Windows environment, and using Rumba HP and
UNIX software, can communicate with HP and UNIX hosts and host applications. Rumba software
combines the convenience, ease of use, and versatility of PCs with the power of HP and UNIX hosts and
host applications.

How to Transfer Files Using Rumba HP and UNIX
Using the Rumba HP file transfer feature, you can copy files from a PC to an HP host or from an HP host
to a PC.

Similarly, using the Rumba UNIX file transfer feature, you can copy files from a PC to a UNIX or VMS host,
or from a UNIX or VMS host to a PC. Rumba software works transparently with any UNIX or VMS host
operating system.

Rumba software simplifies the file transfer setup process by using typical Windows menus and dialog
boxes. It reads and lists PC and host files, and lets you transfer files in the background. You can also
perform file transfers using the configurable toolbar.

Understanding the file transfer process
Rumba software uses protocol-driven transfer methods. This means that files are transferred using a set of
rules known as a protocol. The specific details of the protocols are not important to users, but the protocols
specified on the PC must match that used by the host computer. For example, Rumba software will not
work if the host is attempting to transfer using the Kermit file transfer protocol and the user selects Text as
the transfer protocol to be used. To minimize such conflicts, Micro Focus strongly recommends that users
take advantage of the Rumba Initiated and Macro options.

Even using Rumba Initiated, the user must know which protocols are supported by the host. If the protocol
chosen by the user is not supported by the host, the Rumba software will not work. Also, the host must be
at a command prompt, ready to accept the transfer command before you attempt a file transfer.

Here is an overview of the steps you must follow to transfer files:

1. On the Home tab, click Send or Receive. (In the Classic interface, click Transfer > Send to send a file
from your PC to the host, or Transfer > Receive to receive a file from the host.)

2. On the Setup tab, specify the file type, transfer protocol, and host environment. You can also have
Rumba software initiate the file transfer operation by checking the Rumba Initiated box. For example,
“sz” is used for sending files to the host via Zmodem.

When this option is checked, you may specify the name of the host’s transfer program which Rumba
software will use when automatically initiating the transfer.

If Rumba Initiated is selected, the software provides some standard commands based on the protocol
selected. If the local setup is different, commands can be entered that are specific to the site. Whatever
is entered in the To Host Program Name or From Host Program Name fields is sent to the host exactly
as it is typed.

Note: If the host is a VMS system and the full program name is given, Rumba software defines a
foreign command to start the program.

The default setting for Rumba Initiated is Off. The Rumba Initiated option is not available for Text file
transfers or when Other is selected in the Host Environment box.
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When you choose a file transfer protocol, Rumba software displays a configuration tab corresponding to
that protocol. For example, if you choose the Text transfer protocol, the Text Configuration tab is
displayed.

3. Click the tab that is associated with the transfer protocol you have chosen, and then specify the
information needed by the transfer protocol.

4. Click the Files to Transfer tab and select the files you want to transfer.

Note: If Rumba Initiated is checked, and the correct host is not specified, you will not see any host
file information when you view the Files to Transfer tab.

5. Click OK.

MPE file transfers
For Rumba HP only, file transfer capabilities are now available for systems using the MPE host
environment. While you’re connected in MPE mode, HPXFER is the only protocol available. MPE file
transfers are always Rumba Initiated.

MPE file transfers require special setup by the host administrator. Follow these steps to set up MPE file
transfers:

1. In the registry, create a new value:

HKEY_LOCAL_MACHINE\SOFTWARE\WallData\

Office\HP\MPEBOOTSTRAP

The type of the value is DWORD and the value should be set to 1.

2. When the File Transfer dialog is invoked in Rumba software, a new button labeled BootStrap will be
visible. Clicking this button will cause the WALLXFER.BIN file to be transferred to the MPE system.

3. After the WALLXFER.BIN file is on the host, the administrator should set its file permissions to execute
(“X”) and move it to the PUB.SYS group.

4. Once the file has been transferred for the first time, the BootStrap functionality should be disabled by
deleting the registry key or changing its value to 0.

Note: This procedure needs to be done once for each MPE system with which you will be transferring
files.

Using compatible file transfer protocol versions
Rumba software may have trouble supporting certain freeware or shareware versions of a given file
transfer protocol. For example, there are many public domain versions of Xmodem and Ymodem which are
known to improperly implement the protocols. Make sure that you are using a file transfer protocol version
that is current and well-supported by a known and reputable vendor.

8-bit binary transparent communications
It is necessary to perform file transfers using an 8-bit “binary transparent” protocol. A transparent channel
is a communication method and medium that does not use any of the byte values for control of the channel
itself. An 8-bit channel does not use any of the bits in an 8-bit character set for control of the channel (for
parity, for example) and can transmit all 256 codes in the character set. An example of a channel that does
not meet this criteria is a CompuServe“ connection using 7 bits and Even parity. This is important when
transferring data that contains anything that is not printable text in the data stream. If the channel you are
using is not transparent, the Kermit protocol performs the most reliable file transfer; channels less than 8-
bits wide are not supported.
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Using Rumba Macros to Transfer Files
Because many Rumba software users are not familiar with file transfer procedures, it’s a good idea to
configure macros they can use for the file transfers they commonly perform. The Rumba macro utility
allows you to automate many Rumba software functions, including file transfers.

To create a file transfer macro:

1. On the Tools tab in the Macros group, click Edit to open the Macro Editor. (In the Classic interface, click
Tools > Edit Macro.)

2. Click the file transfer send button or the file transfer receive button.
3. Configure the file transfer and click OK.
4. Choose Save from the Macro Editor File menu, give the macro a name, and click OK.
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AS/400 and Mainframe Printers
This section provides a general overview of Rumba for both the AS/400 and Mainframe printer.

AS/400 and Mainframe printer features
With the Rumba printer, you can route jobs from your printer queue to the Windows printer of your choice.
You can also:

• Preview documents before printing
• Save documents to print later
• Print to a file
• Change page layout, formatting, and printer properties
• Use the PC Printer Queues display, and the AS/400 Printer Queues display, to monitor and control

printers and print jobs
• Use the Print Log display to monitor completed print jobs
• Use advanced printer features such as font mapping and character translation
• Install the Rumba AS/400 printer as a Windows system service

Printing AS/400 and mainframe documents on a PC
printer

When you have configured and connected the Rumba printer, you can send host print jobs to your current
Windows printer by simply opening the host application, and then printing the document as usual. You can
also preview documents and save them to print later, print to a file, or change the page layout, formatting,
and printer properties.

If you attempt a Rumba printer operation, but have not installed a Windows printer, the Printer Wizard
automatically prompts you to install a Windows printer, and guides you through the installation process.
Normally, you add printers by clicking the Printers icon in your Windows Control Panel.

Help topic: Working with data > The Rumba AS/400 and Mainframe Printers > Printing

Viewing documents before printing
You can use Print Preview to review page layout and formatting, change Windows printer properties, or
save documents to print later. When Print Preview is active, a picture of each printed document displays on
the screen before the document is sent to the printer.

Monitoring and controlling printers and print jobs
You can control the behavior of the Rumba mainframe printer by using Direct printing, Printer sharing, and
End print job. You can also monitor your printers and print jobs with the Printer Queues display, and use
the PC Printer Queues display to:

• Monitor and control current print jobs
• Control your Windows printers
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Help topic: Working with data > The Rumba AS/400 and Mainframe Printers > Printing

AS/400 Printer Queues
The AS/400 Printer Queues feature is available only on hosts with operating systems of OS/400 V3R1 or
later. This display lists the AS/400 printer queues to which you have access, along with the print jobs in
each printer queue, and the status of each job.

You can:

• Customize the display to list only the print jobs you are interested in.
• Toggle this display on and off by choosing AS/400 Printer Queues on the View menu.

Note: AS/400 Printer Queues will not work if the transaction program (TP) on the host has not been
started. The command to start all host servers is: strhostsvr *all The command to start the
Network Print Server TP is: strhostsvr *netprt

Direct printing
With Direct printing, you can print both unlimited characters per line, and graphic data streams without
interpretation by the printer driver. Host data is translated from EBCDIC to ASCII and sent directly to the
printer, bypassing the printer driver.

Note: When Direct printing is active, Print Preview does not work. The print job will go to the printer
without any preview.

Printer sharing and End print job
Use the Printer sharing option (default) or the End print job option to specify how Rumba software will
recognize the end of a host print job.

With Printer sharing, the current print job is released when Rumba software receives the Change Direction
Indicator (CDI) that is usually sent with the SNA End Bracket command to indicate the end of a print job.

You can use Printer sharing for most host print applications. However, some host applications do not send
an Unbind command to signal the end of the print job. If you encounter pagination problems, or if host print
jobs terminate before document printing is complete, then use the End print job option.

With End print job, if the host does not send an Unbind command at the end of the print job, Rumba
software will wait for the user-specified timeout period, and then release the print job if data is not received.

PC Printer Queues
This display lists the printer queues for all network and local printers set up in your Windows Print
Manager. Information is displayed for all print jobs (not only jobs from the host) and for all users. See the
online help for procedures on using this display to:

• Pause, resume, restart, cancel, and purge print jobs
• Add, delete, and change printers
• Change Windows printer properties

Viewing print job history
The Print Log display lists documents that have printed on the PC printer, including documents printed
from host as well as from PC applications, saved print previews, documents that did not print due to errors,
and held or canceled documents. Information displayed includes:

• Name of the host system
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• Device name of the PC printer
• PC printer type
• Status of the print job, or location if the print job was saved
• Number of pages
• Date and time the job was processed

Formatting printed documents
The way a printed document looks is affected by the capabilities of the target PC printer, the printer driver,
Rumba software formatting options, and host print file values. You can use the format specified by the
host, the default Windows format for the PC printer (LU1 print jobs only), or you can customize the format
by specifying options such as text styles, page orientation, scaling, margins, spacing, and print quality.

Help topic: Working with data > The Rumba AS/400 and Mainframe Printers > Printing

Host Print Transform
The Host Print Transform feature is available only on hosts with operating systems of OS/400 V2R3 or
later. Host Print Transform changes the AS/400 print data to the ASCII format needed by a particular PC
printer before the data is sent to the Rumba AS/400 printer. The Rumba AS/400 printer then passes the
data directly to the PC printer. In this way, the Rumba printer and Windows printer drivers are minimally
involved in the process.

To use Host Print Transform, follow these steps before connecting the Rumba AS/400 printer:

1. From the Connection menu, choose Configure, then select Rumba Router from the list of installed
interfaces.

2. On the Rumba Router tab, click the Transform button.
3. Click the Host Transform Enabled option, then change the configuration parameters as needed.

You can also configure Host Print Transform directly on the AS/400 host.

Font mapping
When a host document is sent to the PC printer, it includes both text and format information. The format
information includes the font size and style of the printed document. When the document prints, the closest
matching font is selected from those available on the PC printer.

From the Options menu, select Font Mapping.

From the Font Mapping dialog box, you can select a specific Windows font, type size, and style for each
font sent from the host. You can also:

• Create multiple font map files and associate each with a different profile, to be used with different
printers

• Use only PC printer fonts, to speed printing

Help topic: Working with data > The Rumba AS/400 Printer > Printing > Advanced printer features

Character translation
When printing host documents on a PC printer, host EBCDIC characters are translated to ANSI characters.
Each national language has its own unique character translation table. By default, your character
translation table is associated with the Host Character Set you selected when configuring your printer
profile.
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If your application requires that characters be translated differently than the default table, you can create a
customized translation table to meet your needs. The customized table is saved in association with your
printer profile. You can also create multiple customized translation tables to use with different profiles.

Help topic: Working with data > The Rumba AS/400 Printer > Printing > Advanced printer features
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Rumba Telnet Edition
Rumba Telnet Edition represents the total TCP/IP solution. Rumba software supports every TCP/IP
network application: connections to multiple hosts, printing, file transfer and file system sharing, and
working in the Internet.

This section introduces you to Rumba Telnet Edition and provides an overview of core Rumba Telnet
Edition capabilities.

Rumba applications for TCP/IP networks
The Telnet edition of Rumba supports every TCP/IP network application: connections to multiple hosts,
printing, file transfer and file system sharing, and working over the Internet. The following tables describe
the functions performed by the Rumba host applications (AS/400, Mainframe, UNIX, and HP).

For AS/400 hosts
With the Telnet edition of Rumba you can view AS/400 host applications using two different methods, print
host applications, perform a variety of file transfers, and seamlessly share AS/400-based file systems with
workstations.

The following provides brief descriptions of Rumba AS/400 host applications grouped by function.

• Display

Rumba AS/400 Display presents the traditional AS/400 display in a Microsoft Windows application: the
Rumba window. Includes support for the Text-Assist function of OfficeVision/400.

Users can run multiple host sessions, displaying and working with host applications simultaneously.
• Printing

Rumba AS/400 Printer (3812 emulation) enables you to route jobs from your AS/400 printer queue to a
Windows printer of your choice.

For Mainframe hosts
With Rumba Telnet Edition, you can view and print mainframe host applications using two different
methods, perform a variety of file transfers, and seamlessly share mainframe-based file systems with
workstations.

The following provides brief descriptions of Rumba applications grouped by function.

• Display

Rumba Mainframe Display presents the traditional mainframe display (3278/79) in a Microsoft Windows
application: the Rumba window. Includes GDDM.

Users can run multiple host sessions, displaying and working with PC and host applications
simultaneously.

• Printing

Rumba Mainframe Printer (3287 emulation) presents the traditional IBM 3287 printer functionality in a
Microsoft Windows application.

• File transfer

Rumba Telnet Edition | 99



Rumba Mainframe Display Supports many host file transfer programs including IND$FILE.

Supports ASCII or binary transfers, Write Structured Field or Buffered data streams, EBCDIC-to-ASCII
translation, and data compression.

For UNIX hosts
With the Telnet edition of Rumba you can view and print UNIX host applications using two different
methods, perform a variety of file transfers, and seamlessly share UNIX-based file systems with
workstations.

The following provides brief descriptions of Rumba applications grouped by function.

• Display

Rumba UNIX Display presents the traditional VT display in a Microsoft Windows application supporting
the whole range of VT terminals from VT 52 to VT 420 as well as VT340 ReGIS, Sixel, and Tektronix
4010/4014 graphics support.

Users can run multiple host sessions, displaying and working with host applications simultaneously.
• Printing

Rumba for UNIX Display/Terminal-routed printing prints the display screen, selected text, and full color
graphics, or routes print jobs from the host printer through your Windows print driver.

• File transfer

Rumba for UNIX Display supports Kermit, Text, and X-, Y-, Z-Modem file transfer protocols.

For HP hosts
With Rumba Telnet Edition you can view HP host applications, print HP applications using two different
methods, perform a variety of file transfers, and seamlessly share HP-based file systems with workstations.

The following provides brief descriptions of Rumba applications grouped by function.

• Display

Rumba for HP Display presents the traditional HP terminal types in a Microsoft Windows application.

Users can run multiple host sessions, displaying and working with host applications simultaneously.
• File transfer and file system sharing

Rumba for HP Display supports Kermit, Text, and X-, Y-, Z-Modem file transfer protocols for UNIX
operating systems.

MPE native file transfer provides a client server file transfer solution allowing users to transfer files to or
from a HP 3000 using a proprietary Z-modem based protocol. The server side application can be
downloaded to the host via the Rumba host link.

Getting connected
The procedure for connecting to a remote host or source depends on which application you use. Refer to
the Connecting to a host section of the help for information on configuring a connection.

If you plan to use: Reference

Rumba AS/400 Display Use the Connection Configuration dialog box to configure
a Rumba Router TN5250 host link.
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If you plan to use: Reference

Rumba Mainframe Display or Printer Use the Connection Configuration dialog box to configure
the TN3270E interface.

Rumba UNIX Display Use the Connection Configuration dialog box to configure
an interface.

Rumba HP Display Use the Connection Configuration dialog box to configure
the appropriate interface.
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Automating Rumba Software
By automating complex and common tasks, both you and your users can make Rumba software do more
for you. You can use either macros or scripts to simplify your work. Macros record a series of actions, such
as keystrokes and commands to automate tasks.

If you choose to install the separate Script Editor you can use scripts to automatically manipulate sessions.
For example, you could write a script to open a new session and connect to a host.

This section provides you with background information on using macros. Detailed information on the
Rumba Script Editor can be found in its online help.

Note: One of the easiest and most effective ways to familiarize yourself with Rumba Script Editor/
Player capabilities is to run the demo scripts provided with this application. Run one of the script files
(such as, demo.csf) to see how a script works. You can also copy a sample script file and edit it to
suit your needs.

Use macros in conjunction with hotspots, custom toolbar buttons, and keyboard shortcuts to complete
tedious log-on procedures and other common tasks with a single mouse click or key stroke.

For example, distributing macro files and Hotspot libraries to your users provides them with valuable
production tools that they do not even have to take the time to create.

Creating macros
Macros record a series of actions, such as keystrokes and commands. Once you record a macro, you can
play it back to automate routine tasks. For example, with the click of a button, a macro can connect your
PC to a host, test the return strings, and then start an application.

There are two ways to create a macro:

• Choose Record Macro from the Tools menu or click the icon, and then perform your keystrokes and
commands. Be sure to save the sequence as a macro file after recording.

• Choose Edit Macro from the Tools menu, and then build a sequence of commands with the Macro
Editor.

To combine the speed of recording macros with the power of written command lines, record the basics,
and then use the Macro Editor to edit and add to the macro sequence. For details about macro commands,
see Macro Commands.

Connect and disconnect macros
Connect macros run automatically each time you connect to a host. For example, the connect macro could
contain commands to enter a User ID and password, choose menu items, and open a host application.
You can distribute to your users macros that automatically log them on and take them to the correct host
application.

In order for a connect macro to work, the communications interface must be properly configured, and the
macro must be saved from within the profile with which it is to be used.

Disconnect macros run automatically each time you disconnect from the host. For example, the disconnect
macro could run another program on the connected host before logging out. It is important to note that, if
you have a disconnect macro defined, you do not disconnect from the host until after the macro has been
performed. If you are disconnected from the host because the physical connection has been broken, then
the disconnect macro does not run.
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Specifying connect and disconnect macros
Any given profile can have only one connect and one disconnect macro. To specify that a macro
automatically runs upon connecting or disconnecting:

1. From the Tools menu, choose Edit Macro.
This opens the Macro Editor dialog box.

2. Select a macro from the Macro Name box.

3. Under the Play Macro On area, check either the Connect or Disconnect box.

4. Select Save from the File menu to save the macro, and close the Macro Editor.

Help topic: Simplifying your work > Automating Tasks > Macros > Creating and
editing macros

Macro Editor
Recording keystrokes and commands may not always produce the macros you need to accomplish
complex tasks. When it does not, use the Macro Editor to work with all the macro commands and create
complex macros using advanced macro features. Appendix A shows the various commands available for
each host.

You cannot record many of the macro commands, such as Pause Macro, Goto Label, Compare Values,
Message, and Prompt, because they are not commands or keystrokes. For example, you may need a
macro that pauses between two macro commands to give the host enough time to respond.

Copying data between applications
You can use Copy From and Paste To commands in the Macro Editor to designate an area of a display
screen to be copied from one application and pasted into another application. In order to do this you need
to specify the application and the location (in terms of rows and columns) from which the data should be
copied, and the application and location to which it should be pasted.

Note: If you select Microsoft Excel 97 as the application type when using either the Copy From or
Paste To macro, the dialog box changes and you must provide additional information in the File and
Worksheet fields.
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Using variables
Variables are one of the most powerful macro features. Using variables is like writing your own macro-
driven application. With variables, you can create interactive macros that respond to user input and
perform specific sets of commands.

To open the Variable Setup dialog box:

1. From the Tools Menu choose Edit Macro to open the Macro Editor dialog box.
2. Right-click in the macro display area.
3. Choose Variable Setup from the popup menu.

In the Variable Setup dialog box, you can select a variable, such as a password or user ID, and define its
value based on host screen information, static text, and user input. The variable values are available for
the Type, Message, Compare Values, Goto Label, and Prompt commands.

For example, you could create a prompt dialog box to request a password from a user, and then save it as
a variable. The variable containing the user's password is then available for any Type, Compare Value,
and Message commands you have included in the macro sequence. For example, you could use a
Compare Values command to check the password, and then end the macro or even disconnect the PC
from the host

Using variables example

The following example shows you how to define a screen variable and use it to execute specific actions
based on a variable returned by PROFS.

This is a long example, which contains examples of creating several different kinds of macro commands. If
you are unfamiliar with macros, we recommend that you create the macro contained in the example to
familiarize yourself with the macro editor and macro command syntax.

1. Choose Edit Macro from the Tools menu.
2. Name the Macro Flow Example.
3. Right-click in the macro display area, and choose Variable Setup from the popup menu to open the

Variable Setup dialog box. Click the Variables list box, and choose Variable for screen text.
4. From the Variable Types box, choose Screen Variable, if it is not already selected.
5. Click the Screen Variable tab.

6. Change the Get text from Column value to 78.
7. In the Get how much text? area, click This many characters, and type 3 in the box.
8. Click OK to save the settings.

This gets 3 characters from the screen at row 1, column 78 and saves them as a variable that your
macro can use.

The following steps reference buttons on the toolbar above the macro display area.
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1. Open the Goto Label dialog box. Select Variable for screen text from the label list, and click OK.

2. Open the Message dialog box. Type Screen Unknown and click OK.
3. Open the Goto Label dialog box. Type Macro End and click OK.
4. Open the Label dialog box. Type A00 and click OK.
5. Open the Message dialog box. Type PROFS Main Screen and click OK.
6. Open the Receive dialog box.
7. Type Mail Waiting in the Find text box.
8. Under Screen Position, click Only at row, column, and type 24 and 69 in the Row and Column boxes.
9. Under Timeout, click Seconds, and type 30 in the box.
10.In the Otherwise box, type NoMail, and click OK.
11.Open the Message dialog box. Type You have Mail and click OK.
12.Open the Label dialog box. Type NoMail and click OK.
13.Open the Goto Label dialog box. Type Macro End and click OK.
14.Open the Label dialog box. Type C00 and click OK.
15.Open the Message dialog box. Type You are on the Open Mail Screen and click OK.
16.Open the Goto Label dialog box. Type Macro End and click OK.
17.Open the Label dialog box. Type E01 and click OK.
18.Open the Message dialog box. Type You are reading a message and click OK.
19.Open the Label dialog box. Type Macro End and click OK.
20.Add Exit Macro to end of macro.

Your completed macro should look like this:

21.Choose Save from the File menu, and close the Macro Editor

This macro looks at the current PROFS screen and returns a message box containing a description of
what was found. You can use this macro as a model to test different macro functions.
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Running Macros
This section assumes that you have created your macros. It tells you and your users how to run the
standard Rumba macros and your custom macros in any of the several ways.

Running standard or custom macros
• From the Tools Menu, choose Run Macro or click the icon, and then select the macro you want to run.
• Associate a macro with a Hotspot, and then click the Hotspot text on the host screen to run the macro.
• Assign a macro to a toolbar button, and then click the button to run the macro.
• Link a macro to a keystroke, and then type the keys to run the macro.
• Macros can also be run from other macros. When editing the Run application command, select Macro

Files from the Files of Type list. Choose the macro you want to run. When the macro comes to this
command, it pauses, runs the new macro, and then runs the remainder of the originating macro.

Each host application type has a default macro directory.

Macros as Hotspots
Hotspots are words or sentences on the host screen that run macros when clicked. Hotspots add point-
and-click capability to host screens, making them more like the other Windows applications. Instead of
requiring users to master complicated command line statements, you can distribute Hotspot libraries to
enable users to click through host screens with fewer errors and more efficiency.

You can find procedures for creating and editing Hotspots in the online help.

Help topic: Simplifying your work > Automating tasks > Using hotspots on host screens > Creating
and editing hotspots

What are Hotspots
You can make any non-protected text on a host screen into a Hotspot and associate that text with any
macro. The host screen shows Hotspots as 3D buttons (see below). When you click a Hotspot button, the
macro runs.

For example, you could make the text in a list of options into Hotspots that automatically enter the
appropriate option when clicked.
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Hotspots are saved in libraries with an .hsp extension. You can create multiple libraries with distinct
configurations. To use different collections of Hotspots, or to run different macros with the same Hotspot
text, users just select the corresponding library.

Creating and distributing Hotspot libraries
You can create whole libraries of Hotspots and distribute them to users. When the user enables Hotspots,
the macro runs when the user clicks the Hotspot. The macros used in your Hotspots are saved with the
Hotspot library, so you do not need to distribute the .hsd files to your users.

Macros on your toolbars
Macros can be linked to toolbar buttons, and incorporated into your standard Rumba Toolbar or placed on
custom toolbars. With custom toolbar macros, your users can accomplish complex key sequences and
commands without errors and without even touching their keyboards.

Help topic: Simplifying your work > Automating tasks > Working with Macros > To assign a macro to
a toolbar button

Keyboard macros
If your users do not like switching between keyboard and mouse as they work, they can link macros to
keystrokes. Without even taking their hands off the keyboard, your users can run the macros you distribute
which create shortcut keys for complex key sequences.

Distributing Keyboard files
The keyboard files are located in the private directory\hostname\keyboard directory as .map files.
To distribute keyboard files, you must distribute the .map file and any corresponding macro files (.rmc
& .mac) that are linked to mapped keys. The macro files are located in the private directory\hostname
\macros directory.
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Macro Commands
The macro commands available for each host type differ slightly. The following tables list the macro
commands available for each host. Each table lists the macro command, followed by a brief description of
its function.

Mainframe macro commands
An asterisk (*) indicates macro commands that you cannot record, but can create and edit in the Macro
Editor.

Macro Command: Use to:

Connect Connect the PC to the mainframe host

*Compare Values Compare two character strings or variables, and perform
the specified commands based on the results

Cursor Position Position the cursor on the host screen

Disconnect Disconnect the PC from the mainframe host

Exit Macro End the macro sequence

File Transfer Receive Receive the specified file transfer

File Transfer Send Send the specified file transfer

*Goto Label Jump to the specified Label command in the macro
sequence

Keystroke Send a function key to the host application

*Label Create a marker in the macro sequence to which a Goto
Label command can jump

*Message Show a dialog box with the specified message

*Pause Macro Pause the macro sequence for the specified number of
seconds

*Prompt Create a dialog box that prompts the user for input

Receive Search the host screen for the specified characters

*Run Application Run an application on the local PC

Copy From Copy selected areas of a display screen to the clipboard
for pasting into an application or display screen

Paste To Paste clipboard information to an open application or
session.

Type Send the specified characters or variable to the host
screen

AS/400 macro commands
An asterisk (*) indicates macro commands that you cannot record, but can create and edit in the Macro
Editor.
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Macro command: Use to:

Connect Connect the PC to the AS/400 host

*Compare Values Compare two character strings or variables, and perform
the specified commands based on the results

Cursor Position Position the cursor on the host screen

Disconnect Disconnect the PC from the AS/400 host

Exit Macro End the macro sequence

*Goto Label Jump to the specified Label command in the macro
sequence

Keystroke Send a function key to the host application

*Label Create a marker in the macro sequence to which a Goto
Label command can jump

*Message Show a dialog box with the specified message

*Pause Macro Pause the macro sequence for the specified number of
seconds

*Prompt Create a dialog box that prompts the user for input

Receive Search the host screen for the specified characters

Copy From Copy selected areas of a display screen to the clipboard
for pasting into an application or display screen

Paste To Paste clipboard information to an open application or
session.

*Run Application Run an application on the local PC

Type Send the specified characters or variable to the host
screen

HP and UNIX macro commands
An asterisk (*) indicates macro commands that you cannot record, but can create and edit in the Macro
Editor.

Macro Command: Use to:

Connect Connect the PC to the UNIX or HP host

*Compare Values Compare two character strings or variables, and perform
the specified commands based on the results

Disconnect Disconnect the PC from the UNIX or HP host

Exit Macro End the macro sequence

File Transfer Receive Receive the specified file transfer

File Transfer Send Send the specified file transfer

*Goto Label Jump to the specified Label command in the macro
sequence

Keystroke Send a function key to the host application

*Label Create a marker in the macro sequence to which a Goto
Label command can jump
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Macro Command: Use to:

*Message Show a dialog box with the specified message

*Pause Macro Pause the macro sequence for the specified number of
seconds

*Prompt Create a dialog box that prompts the user for input

Receive Search the host screen for the specified characters

*Run Application Run an application on the local PC

Type Send the specified characters or variable to the host
screen
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Connection Tools
With Rumba Tools, you have a set of utilities designed to boost your productivity. This section provides
overviews and tips for the most commonly used Rumba Tools.

• Rumba APPC Configuration utility
• Administrator Override File
• Rumba AS/400 Communications utility
• Rumba Communication Monitor

Note: For details on additional Rumba Administrative Tools, see the Rumba Utilities and Advanced
sections in the online help.

The following summarizes the purpose and supported hosts for each of these administrator utility.

• Rumba APPC Configuration utility

Simplify the process of creating connections throughout your network.

Applies to mainframe and AS/400.
• Rumba Administrator Override File

Implement a single configuration file for multiple users and reduce the time required for setting up and
troubleshooting workstations.

Applies to mainframe and AS/400.
• Rumba AS/400 Communications utility

Simplify the process of creating communication sessions throughout your network.

Applies to AS/400.
• Rumba Communication Monitor

A workstation-connection monitor you can use to analyze the current status of each configured link.

Applies to mainframe and AS/400.
• Rumba Trace Console

Simplify the mechanics of tracing communication sessions to improve your efficiency in troubleshooting
and solving network problems.

Applies to mainframe, AS/400 and HP UNIX.

Rumba APPC Configuration Utility
The APPC Configuration utility assists you in building a configuration file for the Rumba SNA engine. This
configuration file defines the elements listed below. Each of these elements is discussed in this section.

• Connections
• AS/400 modes
• Remote and local logical units
• CPI-C side information file
• Transaction programs
• Conversation security

The following figure illustrates the Rumba APPC Configuration utility main display:
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Because the Rumba APPC Configuration utility uses a feature-rich graphical user interface, when you
make an addition, change, or deletion you only need to select a box and click a button.

The Rumba APPC Configuration utility saves configuration parameters in a file with a .cfg extension. You
can save as many configurations as you need for distribution later, or you can build an administrator
override configuration file for your users.

With the Rumba APPC Configuration utility, you can set values for different local and remote environments.
For Common Programming Interface-Communications, you can add or modify side information entries.
You also have the option of assigning User IDs and Passwords to incoming remote transaction programs.

Connections
Use the Rumba APPC Configuration utility to name connections and add interfaces quickly and without
error.

Working in the background, the Rumba APPC Configuration utility creates a local LU name (logical unit
name) for your connection from your network name and control point name. As a default, the Rumba
APPC Configuration utility inserts your computer name for the control point name.

The Rumba APPC Configuration utility allows you to easily add an interface connection. The Rumba APPC
Configuration utility’s Connections box uses a simple graphics scheme that allows you to visually identify
the interface used for your connection.

International character set translation
The Rumba APPC Configuration utility works with the international character set specified in the regional
settings for your workstation. This translation is accomplished using tables that reside in the Program Files
\Micro Focus\Rumba\System\Charsets directory after Rumba software is installed.

These tables (referred to as codepage tables) work with Rumba software as follows:
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• The character set that Rumba software uses is determined by the country that is specified on the
Regional Settings Properties dialog box. Access this dialog box via the Windows Control Panel.

• EBCDIC to ANSI translation (or mapping) for your workstation is based on the codepage table currently
in use.

• The Program Files\Micro Focus\Rumba\System\Charsets directory contains files named
chr2exxx.gen, where “XXX” is the locale code (for example, 037 is the code for USA).

To modify the character mapping for a specific language, modify the corresponding chr2exxx.gen file using
a regular text editor. There are no registry settings or .ini file settings to make or change.

AS/400 modes
AS/400 mode descriptions define a number of session characteristics. These characteristics include the:

• Maximum number of sessions
• Maximum number of conversations
• Pacing values for request and response units

By using the mode description as an APPC system object, you can reduce the number of separate
configuration definitions. The Rumba APPC Configuration utility offers several pre-configured modes.
When in doubt, QPCSUPP is the AS/400 default, although #BATCH offers the best compromise in
communication performance and cost.

Remote and local logical units
The Rumba APPC Configuration utility simplifies the task of managing remote and local logical units. A
local logical unit (LU) represents the local workstation, while the remote logical unit represents the local
workstation conversation partner.

• Logical unit properties

Because the concept of the LU has evolved, it is easier to understand the LU by looking at its
properties:

• Sessions have LUs at each end
• To establish a session, a client must have the server’s LU name, which is known as the Remote LU
• In a hierarchical network, an LU has a defined global address that it uses to route data
• You can assign different LU names to a host’s different subsystems

Note: An LU name does not signify a machine or program name, it designates the role a machine
or program has within a network. For example, an LU name can designate a network server.

• Logical unit configuration tips

Here are a few tips to consider when you use the Rumba APPC Configuration utility to add or change
logical units:

• For a computer client, the LU name default can be the computer name. The Rumba APPC
Configuration utility does this automatically in the configuration process.

• For a server, consider using an LU name alias based on the function, rather than the computer
name. This minimizes disruption if the function is moved to another computer.

• When you are connected to a subarea SNA network, finding an LU name is problematic because
you do not have network node services. In this case, you must configure a remote LU and associate
it with a route.

CPI-C side information file
The Rumba APPC Configuration utility gives you a powerful tool that you can use to easily create and edit
side information files. Previously, when using APPC/LU 6.2 verbs, application programmers had to supply
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the parameters that described the network environment. With CPI-C, these parameters are called out from
a side information file.

The Rumba APPC Configuration utility uses a straightforward process to create a side information file. One
thing to remember is that the side information file is the last part of the configuration process. First you
must define the:

• Network environment
• Session characteristics
• Remote LU information

Transaction programs
You can add a transaction program by naming and associating it with an executable file or command line.
This transaction program (TP) can then have:

• A path to the executable program
• An auto-start option
• Optimum security
• Queueing
• Timeouts
• PreLaunch Counts

The transaction programs you add with the Rumba APPC Configuration utility should fulfill the APPC/LU
6.2 requirements of:

• Being invoked by the LU 6.2 ATTACH call
• Using conversations to communicate with a remote transaction program
• Establishing many conversations with one or more remote transaction programs using distinct sessions

Conversation security
If you have secured the local transaction program (TP), use the Rumba APPC Configuration utility’s
Conversation Security feature to assign user IDs and passwords to incoming TPs.

When an incoming TP attempts to allocate a conversation with the local TP, the local TP reads the User ID
and password. If there is a match, the incoming TP is allowed to access the local TP.

Administrator Override File
A high priority for any system administrator is the standardization of system configurations. When you
create an administrator override file, you provide a set of well-defined parameters that each user can
access. This tool can significantly reduce the time spent setting up and troubleshooting workstations.

Administrator override file definition
How does the administrator override file work? An administrator override (Admin Override) file is a
configuration file you create and then place on the network. Your users can access this administrator
override file for connection information to SNA-type machines. If the connection information changes, you
can use the administrator override feature to make one central change.

For example, when you introduce a new AS/400 to your network, you only have to add the AS/400
information to one administrator override configuration file on your network. The next time a user pulls up
the configuration dialog in the AS/400 display or Rumba APPC Configuration utility, the new AS/400
appears, configured and ready to go.
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Note: The administrator override file does not contain the control point name that will be used for the
connection; this name comes from the user’s machine.

Administrator override file function
How does the administrator override file work? The Rumba SNA engine, AS/400 Display, and Rumba
APPC Configuration utility all have the ability to look at two configuration files at the same time and extract,
as necessary, pertinent information from each file.

Note: Mainframe connection definitions are not supported by the administrator override file. To
understand why this is the case, consider the following:

• Connection definitions for the Rumba Router and AS/400 Display are sharable objects. That is, the
parameters for an AS/400 connection definition and the AS/400 Remote LU Definition can be
common to all users globally. The configuration parameters that are specific to a single
workstation are located in the local LU definition.

• Connection definitions for a mainframe connection are not sharable objects. As an example, for a
Mainframe Display DLC connection, each user must have an individual and unique PUID as part
of the connection definition. If you tried to create an administrator override file for this connection,
all users would share a single block ID and PUID, and only one user could connect at a time.

Basically, when you configure connections to an SNA-type server, the Control Point Name (also known as
the “PC Name” in the AS/400 environment) is what makes one workstation unique from another
workstation. The administrator override file contains the link information; this includes the network name,
destination address, remote LU, side information, and more. Use the local configuration file to store
information applicable only to the workstation.

Local connection configuration
If the administrator override file is set, can you still configure connections locally? Yes! You can enable
Admin Override through the Rumba APPC Configuration utility and still create link configurations that you
store on the workstation in a local configuration file. However, there are restrictions. You are able to
configure local connections only when they have a different connection name and remote LU alias from
any other link residing in the administrator override file. The reason for this is described in the following
section on the precedence of configuration files.

Also, similar to document printing, the AS/400 display shows only connections configured in the
administrator override file, and the user can connect only to these administrator override configured
connections.

Configuration files precedence
The locally-administered configuration file is referenced in the registry as HKEY_LOCAL_MACHINE
\Software\WALLDATA\ConfigFile

The configuration files exist so users can provide their configuration preferences within the
communications environment.

The system-administered configuration file is referenced in the registry key as HKEY_LOCAL_MACHINE
\Software\WALLDATA\Sna\AdminOverrideConfigFile.

You can use the administrator override configuration file as a set of configuration elements that will
override all other configurations. Any configuration element you specify within AdminOverride-
ConfigFile will then take precedence over the corresponding element contained in ConfigFile. This
means that if collisions occur between the elements of the ConfigFile and
AdminOverrideConfigFile, the winner will be the AdminOverrideConfigFile.
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For example: if ConfigFile contains an MPTN link definition named NETRED and
AdminOverrideConfigFile contains an SDLC link definition named NETRED, then
AdminOverrideConfigFile’s SDLC link definition will replace the ConfigFile’s MPTN link definition.

Administrator override file creation
Creating an administrator override file that multiple users can access is not very different than creating a
local configuration file for one user. The only difference is that you store the administrator override file on a
shared network drive.

1. From any machine that already has Rumba software installed, configure the necessary connections
using the Rumba APPC Configuration utility.

2. Save the file as you normally would for a local machine (note the file name in the title bar).
3. Make sure that each connection is valid by connecting to each link configured.
4. Once you are confident that you have a working configuration file, copy the file to a shared directory on

the network. Make sure that each intended user has access to this drive.

Note: Change the Administration Override configuration file’s attributes to Read Only: this will prevent
a user from accidentally corrupting the file.

Editing existing administrator override files
If an administrator override configuration file is already in place and is currently being accessed by users,
we recommend the following as the safest editing method.

1. Using a file manager utility, copy the current administrator override configuration file and rename it.
2. Take off the Read-only attribute if it is present, so that the changes you make can be saved.
3. From the Rumba APPC Configuration utility menu bar, choose Open. Select your newly created file.

Make changes as necessary.
4. Save your new administrator override configuration file.
5. Once you are confident that you have a working configuration file, copy the file to a shared directory on

the network and replace the existing administrator override configuration file.

Note: Change the Administration Override configuration file’s attributes to Read Only: this will prevent
a user from accidentally corrupting the file.

To set user access to administrator override file
1. From the Rumba Administrative Tools program group, start the Rumba APPC Configuration utility.

2. From the File menu, choose Advanced.

3. Click Use Administrator Override Configuration.

4. Enter the full path of the Configuration file that you want the users to access. You can also use the
Browse feature to find the file and its path name.

You can ensure that the next person will get the same configuration by using the setting “Make
configuration available to all users of this machine.” This will use the \\HKEY\LOCAL_MACHINE\
registry instead of the \\HKEY\CURRENT_USER registry.

5. From the File menu, choose Save.

6. Close the Rumba APPC Configuration utility.

When you specify the path, we strongly recommend that you use the Universal Naming Convention (UNC)
instead of a mapped drive letter. If you use the UNC, the connection is not reliant on a mapped drive letter
that could be overwritten or corrupted.

Note: If you use the Browse feature, the path is returned in UNC format.
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If the Rumba APPC Configuration utility cannot find the file you specified in the path for the
administrator override file, a warning is displayed. The situation may be that the workstation is not
currently attached to the network, or that the user does not have permission to access the server that
you specified in the path. If this is the case and you are confident that the path is correct, choose to
continue and exit.

From the operating system’s ComputerName, the Rumba APPC Configuration utility extracts a
default Control Point Name for the local configuration file. If you wish, you can specify another Control
Point Name by simply altering the field. Any changes you make to the Control Point Name are also
automatically made to the Local LU name.

It is necessary that you use a .cfg extension on the file name. If you do not specify an extension, the
Rumba APPC Configuration utility will append .cfg to the file name. The Rumba APPC Configuration
utility supports both 8.3 format file names and long file names.

Assessing workstation setup
Is the workstation you just set up configured properly? The best tool to use in determining if you have set
up the workstation correctly is the Rumba Communications Monitor.

If you selected the APPC Client package install, the Rumba Communications Monitor is installed with a
program icon in the Rumba Administrative Tools program group. If the APPC Client was not installed, the
program will still be installed, but no icon is placed in the group. If this is the case, you can run the program
from the Program Files\Micro Focus\Rumba\System subdirectory. The file name is nof.exe.

The Rumba Communications Monitor starts the Rumba SNA engine and displays the information that the
Rumba SNA engine interprets. If the Rumba Communications Monitor displays the connections that you
configured in the administrator override file, then you are off to a good start.

Administrator override file limitations
While the Rumba SNA engine has the ability to use Rumba administrator override configuration files, the
Rumba AS/400 display and AS/400 printer are the only display-type services that currently use this feature.

The AS/400 Connection Configuration dialog allows the user to see and connect only to links that you
configured in an administrator override configuration file. Local files cannot be accessed.

Note: If your company creates transaction programs that use the Rumba SNA engine, then the
administrator override file should work fine.

Configuration-free workstations
With the Rumba Administrative Tools, you can have self-configuring workstations. By using SMS or a
batch file, each new workstation will look for its:

• Administrator override file
• Local configuration file

Rumba AS/400 Communications Utility
You can use the Rumba AS/400 Communications Utility to locate other AS/400 systems and to configure
or change host connections and link interfaces for the:

• Application Program Interface (API)
• Submit Remote Command application and API
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AS/400 Communications Utility overview
With this utility, the configuration settings are saved in a .ehn file. You can save multiple configurations
under different .ehn file names for later use. The .ehn configuration file can be especially useful when you
are setting up data queues for end users who do not have Rumba AS/400 display or printer capability.

The figure below illustrates the main dialog box of the AS/400 Communications Utility.

The table below maps the major tasks you perform with the AS/400 Communications Config utility to the
appropriate tab on the dialog box.

Table 23: Configuration summary

To: Go to the:

Configure communication interfaces Interface tab

Configure link interfaces Interface tab

Add AS/400 sign-ons Security tab

Select a foreign language’s host character set Character tab

Display APPC error messages Diagnostics tab

Note: If you use Rumba AS/400 Communications to configure EHNAPPC, then all non-display and
non-printer sessions will use the same configuration parameters.

For example, if you configure EHNAPPC to connect to BIGSYS via APPC token ring for Data
Queues, all other hosts (except for Display, Printer, and possibly RDA) will connect via APPC token
ring.

AS/400 Communications Utility link configuration
To use the Rumba AS/400 Communications Utility to configure links:

1. Click the Interface tab.

2. Select a communications interface, then click Configure.

For specific information on configuring, refer to the help section for the selected interface, found under
Connecting to a host.

3. Select a system name, then click Add.

4. Select a link.
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5. Click the link interface tab, then add or change configuration values as needed.

6. From the File menu, choose Save, or click the Save icon.

By default, the configuration is saved as an .ehn file.

Click the Advanced tab to specify a logical unit with a name different than your system’s.

Communication Monitor
The Rumba Communication Monitor is a valuable utility that helps you monitor, troubleshoot, and optimize
your network. Also, you can view non-configured system links.

The Rumba Communication Monitor displays what the Rumba SNA engine finds. The left pane shows that
the APPN link is not connected and the right pane gives detailed information about the link.

Note: Even though you can use the Rumba Communication Monitor to start and stop links (either by
the menu or by right clicking your mouse), we recommend that in normal circumstances (when you
have a transaction program in process or an open Rumba Display session) you start and stop links
and sessions from your Rumba display session.
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Diagnostic and Development Tools
The diagnostic tools available in the Rumba Administrative Tools folder provide you with a set of powerful
and cost-effective features that are designed to boost your productivity. This section gives you overviews
and tips for the Rumba Trace Console and Rumba Development tools.

Rumba Trace Console
The Rumba Trace Console is a valuable tool that combines several trace options in a common utility.
When you are troubleshooting a problem for an end user, you can ask the user to trace and record
communication sessions with the Rumba Trace Console. Later, you can selectively play back the binary
data file to troubleshoot the problem. This section discusses the following aspects of working with the
Rumba Trace Console:

• Application program interface options
• Difficult troubleshooting tasks
• Display software code version
• Playback display and printer data stream trace

By default, all application program interfaces (APIs) are selected for trace, but you can limit trace data and
select only the APIs you want to trace. There are two guidelines for this decision:

• Trace options can have an impact on system performance, so you may want to use the trace APIs as
filters when isolating a known problem.

• When diagnosing a problem, it often requires many types of trace information to effectively investigate
the system state. You may want to select all APIs (default) to capture all available information and direct
output to an unformatted file to send to Micro Focus Technical Support.

Application program interface options
The Rumba Trace Console gives you the following API options:

• Mainframe Display Data Stream (DSA)
• Mainframe Printer Data Stream (DSA)
• AS/400 Display Data Stream (DSA)
• AS/400 Printer Data Stream (DSA)
• UNIX/HP Display Data Stream (DSA)
• SNA Communications (includes APPC, CPI-C, LU 6.2, ACSSVC, and SNA)
• Micro Focus EHNAPPC (a standard AS/400 interface for APPC)
• Link Layer Communications for all network architecture drivers
• Rumba Display APIs (includes DDE, EHLLAPI, and WinHLLAPI)
• Host System APIs (includes Submit Remote Command)
• Rumba Event Viewer

Note: To view trace data while running the trace, be sure that the Display option is checked on the
Options menu. This is the default setting.

Be aware that only 1000 lines of the most recent data is displayed. Also, note that the formatted file is
distinct from the display file and carries more data. When large amounts of trace data are being
saved, a larger trace buffer size tends to prevent trace buffer overruns. The default size is 8 MB.
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Difficult troubleshooting tasks
When there is a network problem, but you do not know what to trace, you can trace all APIs and save the
data in a binary file. Later, this data can be replayed, and you or your support engineers can analyze the
sequence of data from API-to-API. With this sequence in hand, you can isolate where the problem is
occurring and then replay the specific API data.

1. Open the Rumba Trace utility.
2. From the Rumba Trace Options menu, choose Configuration.

The Configure Tracing Parameters dialog box will be displayed.
3. Click Select All.
4. Click the Output tab, and then select the Binary File box.
5. In the text box under Binary Output, type the path and file name to which you want to save the API

data flow (use the extension *.bin).
6. Click OK to close the Configure Tracing Parameters dialog box.
7. Reproduce the problem that you are trying to troubleshoot. (For instance, attempt to run the Rumba

software application that is failing to connect properly.)
8. From the Rumba Trace Options menu, choose Configuration.
9. On the Output tab, clear the Binary File box (turns off the binary option).
10.Click the API Selection tab, choose the APIs you want to analyze.
11.Click the Advanced tab. Under Binary File Replay, type in the name of the file you saved (or you can

use the browse button to navigate to it).
12.Click Replay Now to view the API data flow.

Display software code version
The Rumba Trace Console contains a useful feature that can give you an all-inclusive software code
version report that covers .cfg, .dll, .exe, and .ini files.

1. From the Trace menu, choose Options.
2. Choose Code Version Snapshot.

If you use this feature, you may want to run it either before or after you complete your trace, because this
report is extensive and takes time to run.

Playback display and printer data stream trace
You can use Rumba Trace Console to record the AS/400 or Mainframe Display and Printer Data Streams,
and then analyze and change this data, including adding rules of behavior on key actions and changing
labels. This feature is especially useful for troubleshooting problems, or when you need to create a
demonstration host for training or marketing purposes.

1. Open the Rumba Trace utility.
2. From the Rumba Trace Options menu, choose Configuration.
3. On the API Selection tab, select a single Display or Printer Data Stream to record.
4. Click the Output tab, select the Formatted File box, and then type in the path and name of the file you

want to create (use the extension *.fmt)
5. Click OK to close the Configure Tracing Options dialog box.
6. Reproduce the problem or demonstrate the Rumba software feature you want to record.
7. Close the Rumba Trace utility and then start a Rumba Display or Printer session.
8. From the Connection menu, choose Configure, select Demo Host from the Installed Interfaces box,

and then click the Demo Host tab.
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9. In the Script file box, type in the path and name of the file you saved (or you can use the Browse
button to navigate to it).

10.Click Reconnect to demonstrate the feature or problem you recorded.

Note: The Demo Host can play back only one output file at a time, so make sure that you only choose
one at a time on the API Selection tab of the Configure Tracing Options dialog box.

Rumba Tracer
Rumba Tracer allows users to record information about a program's execution. This information is typically
used by programmers for debugging purpose. Depending on the type and detail of information contained in
a trace log, the information is also used by experienced system administrators or technical support
personnel, and software monitoring tools to diagnose common problems with software.

Trace files can be produced by Rumba software components which have been provided with additional
code for generating binary output trace files. The file can be viewed using the TraceView and tracefmt
utilities, which are part of the Windows Driver Kit (WDK), formerly known as the Driver Development Kit
(DDK). Only TraceView and tracefmt need to be installed from the WDK.

TraceView A graphical viewer for viewing trace files. In addition to trace files, it requires debug
information in the shape of .tmf files generated by the Rumba.

Tracefmt Converts binary trace files to text files which can be viewed by any text viewer.

To start tracing:, run command line:

1. Open a command window.
2. At the system prompt, enter:

RumbaTrace.cmd start

3. To stop tracing, enter:

RumbaTrace.cmd stop

The binary output trace file is stored in the %temp% folder.

The RumbaTrace.cmd script is part of the Rumba installation and is stored in the Rumba System folder.

Rumba does not require restarting after running RumbaTrace.cmd.

Development Tools
Micro Focus provides the following development tools:

• Rumba Development Edition for .NET FrameWork (RDE .NET):

A set of controls and components that enable developers to build applications which incorporate Rumba
displays. The Rumba Developer Edition object module was restructured to be more intuitive. It is now
fully integrated into the .NET C# managed code environment exposed through pre-built .Net binaries.
The interface introduces a much clearer objects hierarchy with some enumerations extensions for
stronger parameters typing, shorter paths to methods and more sharing between session types.

• Rumba Development Add-in for Visual Studio (provided separately):

Provides objects for developers to use in .NET code to add mainframe and AS/400 printing, HLLAPI,
macros and FTX functionality to your Visual Studio projects. RDE .NET controls appear in the Microsoft
Visual Studio Toolbox as Mainframe, AS/400, UNIX and HP displays.

The add-in provides objects for developers to use in .NET code to add mainframe and AS/400 printing,
HLLAPI,macros and FTX functionality to your Visual Studio projects. The add-in also provides:
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• Rumba project templates for different session types
• Integration with the Visual Studio Toolbox for adding Rumba RDE.NET functionality with easy drag

anddrop.
• A menu item that allows ne-click loading of dozens of examples with full source code included.
• Visual Studio code snippets for writing program code more quickly, easily and reliably.
• ‘Intellisense’ support whichprovides auto-completion help information and short descriptions for all

properties, methods, interfaces, and enumerations.
• RDE Tracer to monitors calls to RDE properties, methods and events for easy application tracking. A

tracer class has been added to each display control, which has two methods: start and stop. Once
started, all RDE methods, properties and events used by developers are logged to a log file,
together with their respective parameters and returns values, for easy understanding of the RDE
procedures at run time.

• Full documentation of the RDE.NET API with a description of building you first RDE.NET application.

Note: Although RDE controls appear in the Visual Studio Toolbox for Visual Basic, C# and Visual C+
+ projects, they can be used only for C# and Visual Basic projects .
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